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fntroduction:

IBM Connéctions is the market leading, integrated and sacure social software platform that helps pecple -
engage with networks of expertise in the context of critical business processes in order to act with
confidence and anticipate and respond fo emerging epporiunities.

IBM Connections is comprised of several different social applications. W's important o note that these
applications can he used within an organization as needed —— zli tegether or as individual applications.

iBM Connections is social networking software that consists of these features: Activities, Blogs,

Bookmarks, Communities, Files, Profiles, Forums, Mobile, and Wikis,

You can use these |IBM Connections features to accomplish the foliowing goals:

- Activities - Collaboration tool for collecting, organizing, sharing, and reusing work that is related to a
project goal. ) :

+  Blogs - Online journais that you can use to deliver timely information with a personal touch. You can
use a blog to present your ideas and get feedback from others or learn from the expertise of others
who blog.

+  Bookmarks - Social bookmarking tool for saving, organizing, and sharing Internef and intrafiet
bookmarks. Discover Hookmarks that have been created by others with similar interests and
aexpertisa.

¢ Communities - A web site where people who share a common interesi can interact with one another,
share information, and exchange ideas, Cornmunity members can participate in community-specific
activities and discussion forums, and can share biogs, bockmarks, feeds, and files.

»  Flles - A common repository in which you can store files and share them with others. Store versions
of a file, view who has downloaded a file or commented on i, and see file ratings.

«  Home pagé - A single Web page that helps you manage vour attention by providing a glimpse at
relevani social dafa collected from acrass your subscriptions, notifications, and network of
colleagues.

«  Profiles - Directory of the people in your organization, including the information you need {o form and
encourage effective networks across your organization.

«  Forums - An oniine discussion board where people can ask guestions, share thelr experiences, and
discuss topics of common interest.

= Wikis - A tool for creating wikis that individuals, groups, and communities can use fo capture, share,
and co-author information. View page changes, rafings, and comments.

Together, these tools will help you and your colleagues interact with one another more effectively.
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Description:
The purpose of this [ab is to take you through a walk-through, or demanstration, of the various new
features of IBM Connections 4.0. Developer-spedific features will be covered in depth with succeeding

labs in this workshop. Throughout the lab you will be logging with several users. This heips faciiitates the.
demonstration of the features within Connections.

Cbjective:

At the end of the lab, you shouid be able {o!

= Have a betier understanding of the new feziures provided with IBM Connections
s Feel more comfortable with thé ease of use of IBM Connections- '

= Become betler prepared for the additional labs that provide more depth
Procedure:

lvITE=TO=HY NETWORK |

Step 1 Open a browser and navigate fo the Conneclions homepage
hitps:/igreenhouse.lotus.comfhomepage/ ’

Step 2 Logon using your given user name and password. Navigate to a user's profile that you would
like to network with. - In the upper right corner select Profiles from the drop down list. Search
for someone, a.g. the one sif next to you.

& profiles . e T Eearrhy . -

¥ Al Connections
Corstemize
5 Statuspdaies

Acthsities &
EBlogs
Bookmiarks e any T o e
Cormmunitiss HE:

Filzs

e =eh

Earums dations
W g Proties - - b current resormmendations for

g

. wikis

Adwanced e
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Step 3 When the Profile Search Results is displayed, click on his/her name to display hisfher Profile.
Click on the Invite to My Network button, jocated above the user's activity streaim on the
profile page. ' :

Heather Resds

arkesing Mansget
Chicago, lifincks ., LIS
15325851178
nrEntsgemoas g oon
Loeel Thne: 1015 AR

Reesnt Updatey Backgro el

H
B
i
H

Step 4 This will faunch the Invite to My Network window. By default you have a standard message the
recipient will ses upon recelving this network invitation. You have the option to customize this
message and also add a tag fo associafe with this user once in your network, The last option
in the window wilt aliow you o follow the user in addition to adding them to your network. By
default the follow option is enabled. Make vour selections and click Send invitation.




RS

=

iBMWW

COPYRIGHT I8M CORPORATION 2013, All. RIGHTS RESERVED.

iBM Connections 4.0 — Social Software for Business

network coptact

invite Heather Reeds o hevouwr

rclude & message with your invitaton:

B Also Foliow
Feceive updates shout people you e

ernall sumrmETy.

Add tags for Heather Reed:

follmeding on the-Home gags and in an

For mere information, ses Following peoEes.

Step 5 Once the invitation is sant you wil see a confirmation message above the activity stream. You
will also note a pending invitation message on the user's profile page.

25 Heather Rebds has been imitsd 1o your netvark cortast st -

Heather Reeds |

KMarkeiing Moenoger
Chilcaige, Hings , UsS
1.333-555.1178
hiaedseydermos. ey emn
Eeocad Time: 1:25 PRI

Step 6 The recipient of a network invitation has 2 ways of accepting. The first way is fo navigate fo
vour Actions Regquired section from your Home page.

e
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Gueifing Staried

' Foliswing

Sreyn Lpenias

Action Required

Visw items hat regquine your responss,

Biscorer

v Page

Tian Mg s ivited you to become & network comtact

1 bolay al 421 FR

e —

B Vase i hman tanes

Step 7 Here you sill see a note in the left hand ment calling your attention to a new network invitation.
Clicking inside the network invitation ftself (click on >> within the highlighted invitation) will
show you an embedded winidows where you can Accept the invitation. You'll receive 2
confirmation message indicating that you are now nelwork contacts and foliowing someone,
e.g. Dan Misawa.
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I'm Following
Wiew updstes for peaple and things you are following, and recponRges 1@ you

Urary Rtsaes foliveed ou.
§ Toaym441PH

B Feest §

o irteited vou 1o join their neveatk. | Tday at44l g

Dan Misawa

Hearket Anatest

San Francisee, Califomiia , LIS
1-333-555-1145

i aar aiidurnrailim oo

Ttttk to add youl 1o my Commeerions netwark Corests
1ist. '

] Follow Dan Misava

Step 8 Aliemnatively, vou can access the user's profile that sent you the invitation (for example by
clicking on their name) {Hint: Search on e.g. Dan Misawa fo find his Profile then click on his
profile to display more information) and confirm the network invitation from their profile page by

clicking the Accept Invitation butfon.

Dan Misawa |

Kerket Analysi

San Fyancisce, Califomia, US
1-333-555-1145
dimiisawaiddarnos iz oam
boced Time: 153 PM

Step While logged on, under the I'm Following header you will see g text box with the place holder
fext "What are you working on right now?”. Click inside this text box and enter a simple status
message (Hello World #est), then click Post. You'll see later how this shows up in others’
Activity Streams. Click I'm Following from Connections Home. You will now see that the
invitation status in your activity stream that was accepted.

I'm Foliowing

Vieny updates for people and things you are following, and resporses toyour content.

| HefloWorld stes]

Fost  Cleal

i ere et e ot i o £ C oo b i 0y

Aid a File
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Sratus Uppates, HASH TAGS, AND THE SHare Box

Step 1 In this section you will explore interaction with the Connections activity stream. From your
’ homepage you can explora various ways o interact and share with users, including the new ) ;-

Connections share box. : '

Step 2 -Logon and navigate to Connections Home page. Content on the page rﬁay vary depending on
activity already done.

!@ Home A Eﬁnnsﬂiups B < geant - . i
!
Geting Siarted 'm Following To Do List "
3 View Updsies for psapie and 1hings you are foliswing, ehd sespunses 15 your soient b
«4'tn Fotlowing . H
o et ks o e b i mn 1w Yoo da niod hsve anyio do ilems
Siabes Upgame -
iy Mof#isations %'EW Fﬁ'“"_:izi : Sote my o s
Action Raouires e e o o ) g
Discowe Wikeshs Hiro'L6ts-brak sorme be pratt 5 Davte Corner N
rrnecions comminy idess oves trinks ai 3 local happy 1 :algted parenn
My Page hail Evervans is wekome. 2 pars Corver ,
B8 7 1 b perien ”i
DanNsEem Sep b e T i 9 reisieg parren
Lankng fors o § I3 oo favpsHe tikng ahow Dan
it [
1 4014 Pievipis | New e
5
Evants
Evanis thatvou ase foluwing 20d E ;
planning e afiend.
Step 3 Try a simple status post. Under the I'm Following header you will see a text box with the place
hotder text “What are you working on right now?”. Click inside this téxt box and enter a simple ?
status message (Hello World), then click Post. -
& The message "w}'a_s's'ugc;é'séfully poded.
Fitter By: § &
Dran Misaws Hello World ,
.&.. 310PM

Step 4 You can also utifize hash tags as a new feature of Connections. Try doing ancther stalus
update, but this time end the update with a hash tag (#est).

i R S
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Eran Misawa Hetlo World #test
_§~ Tl at 1050 Al

Step 5 After posting your new status update click on the hash tag. This feature will search information
throughout Connections that you have access to and display search results for all tems that
coentain the hash iag test. As a suggestion, try using this feature at the end of the lab, since
there will be more content added throughout the Iab using the hash tag of #iest.

Status U;jd&tes Search F:‘ESUEtS

Re '%uii* 1-Zaf 2

Sﬁn by Belevarcs | Bals

Hemther Reesds | oy 5:94 PR
Status Lipdage

Hello World #em
Diar Misaws | Tday 583 PM
Status U pdaie

Step 6 The Share box is a new feature fo Connections. The Share box is accessible from any page
so you always have a quick and convenient way io share information and files with others.

Step 7 You can also share status information and files through the Share box. Click on the Share
box, located in the fop right section of your sereen. You should then see the Share
Something window cpen.

?‘;RH Urmectmns " S_egr_ch

To Ro List
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Step 8 Now in the Share Something window you have a few options. You can post through the Status ;
Update {as previously done), you can post using Files, or you can post through Status Update
and include files from either your focal computer or from within Conngctions. Here we will
share a file from your computer info your Connections 2ccount, and also give some context by £
including a status message. Click on the Add a File link underneath the Status Update text i
box, and via the file browser navigate to the Lab_helper_files folder and select the :
ibmlogo.jpg file to be uploaded. (Nofe: The IBM logo graphic file was used for iustration
purpose. You could post any file that is small and easily selectable.) Then dlick OK. :

Add 2 File

{2 My Files Jy Computer ' ]

IBM World Wide Technical Sales
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£3 Mg- Files & fdy Comiputer

File: #% fomlogoing ' ' P

Taps

Step & Once you are back on the Share Something window you should add a status pertaining to
your file you are about to post. Once you have included a status message click the Post

button.

| watld tike 1o share thiz 1858 lego in case anyone efse can use it

& tamlogojpg ®

Step 16 Click on Home then I'm Following. You should now see a confirmation message in addition
to the status update and picture displaved in your activity stream.

B
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Im Following

View updstes for peoe ahd thingsyou wre following, and respansss 1o yaur comtsnt
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Emsepoen Winpow FEATURES

Step 1 Locate a recent post from somecne you are following, displayed in your activity stream, the one
that e.g. Dan Misawa just posted with the IBM logo. Notice when you hover your mouse over
the post, the post is highlighted as blug, and you see right-facing arrows on the right side of the
post. Click on these arrows 1o open the embedded window feature, Within the embedded
window you will see a number of options to interact with the person and the update.

I'm Following

View updates for people and things you are foll oeing, and TESPOTEES 16 YouUl oot

g e

Filter Bae |

Egggjﬂ_iggggg%l weould like 1o share this 18M loge in case anyone efsa can
use it

Step 2 Through this embedded window you can view the person’s profile, repost the update, preview
the attached file, downioad the aftached file, 'like’ the post, comment on the update, and view
recent updates that have been made. Go ahead and interact with this update by dlicking Like
to provide feadback that you are interested in the content. In addition, enter a message into
the Comments section (i.e. Thanks Dan. This will come in handy for my upcoming
presentation.) and then click Post.

leM Worig Wide
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Ban tlseds pasled & messange. | Blaval 535 PM

# wonshd Hike 1o shore tids 1834 fogo Becase
suvore gine oo Lse .

3 ibmiogo. jpg

Predews § Downlad | 21 KB

SR 0 QIS NS

E Ardd a corment

Daws Misshd posed g maésag[e. | Tdayat £:35 P

T wondd {the fo shore tles 1IB5Y lago incose
anyons el comuse L

: E;%E‘f‘i%@%@ ﬁ}g

Pravisve T Downlead | 21 KB

it like this Uinififa

Comments (3} Feeant Updates

Al 2 Commert

Thanks Dan. THiswill come in handy for -
y UECOMIng presentation :
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Step 4
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You can alse fry clicking on the Bownload link located under the aftached file. Upon clicking
you will be given the option o open the file with a default program, or save the file to your local
machine. |

You can close the embedded window by dlicking the ‘X’ located in the fop right area of the
embedded window. You should now notice your recent interaction posted to the activity
stream.

Huather Baeds commernted on [an Wissva's message.

D Missws Dwould ke to share this [BM logo in cose sryone else can use it

§ Tdepal B35 PR 1 like

Hesiter Rebtis Tlay st BIBPM <
Thanks Dag, This will gornain handy for my upeg
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Save anb Derer bems 1w THE ActiviTy STREAM

Step 1 Locsle a post you want io save, hover over with the mouse and click “Bave this” to save the
post i your Saved view. Note the "Save this” link has now changed to say “Saved”, providing
feedback that you have successiully saved this post.

anyone else can gse it

eriatiarn

' .
-

Stepi In the laft navigation menu click the Saved view and this will now display all saved postings.

Cetting é}faned ’ Sa\fed

Yigw the uptates yous have savsd.

I Foligwing
Stetus Updares

Ky Mlotifications

Aeotion Reguired

s S Haahe Reads commented on Dran bisaeia’s message,
Ldan R a Veveltt lice 10 share this IBM logt in case anyore else canuse it

Discover

Ty Page

B oyt BB PR D I lks

Hegshis fovs Triny & 545 PM oL
Thanks Lan. Thiswilt come in handy for my ﬁ_pcm_-r}ing pre:sémaﬁen'
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Step3 Navigate fo the F'm Following section in your ieft navigation menu. Locate 2 post that shows
another user interacfing with one of your activities (Posts may vary depending on others updates) In
this case, you can delete any of your own posis). For example, this could be a post shown in your
“Status Updates” section where another user has “Liked” something you previously posted. When you
hover over updates of this fype in your activity stream you will notice there is an optional X' in the top
right hand cormer of the posting.

Step4 You can delete a post by clicking the X', You will then see the Delete this comment
confirmation window, You can dlick the Delete bution to confirm,

Are you sure you wantio delets this comment?

Step 5 you will notice the message is now gone from your activity streamn and you see a confirmation
message ahove the adivity stream.

1B Werd W’lde Technical Sales
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Creativg 2 Community anp Suaring ConTeRT

Step 1 To access your Communities arez of Connections you can (from any page} mouse over e
Communifies drop down menu &t the top of your screen, and select any of the navigation op‘{ions

below.

ot

You do ot
B Fead

Pt & Owener
I'm a Member
'm Foliowing
Fm mited
Public Commanities

You are not following any communities

Step 2 Once on the Communities page click on the Start a Communify bution,

= fyn an Owrner
I'm & hiember
I'm Following
' Imvited

Fublic Communities

 Start a Community.

Fou da not awn any commurilies.

{88 Fead for these Communiies

i hls
- iBhM World Wide Technical Sales
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Step 3 You are now af the Stari 2 Community page. Here you must {ill out the required fields such
as Name of the cormmunity and the type of access. You can also add optional data such as fags you
want fo associate with your cornmunily, and set up a list of people who can have various authorities to
edit or manage your communities. 1t is also a good idez to provide a description of the community so
users understand what the focus of this community will be. Below the description text box you will see
a few options fv Change Community Theme {where you can pick from a number of existing color
themesy and also an area to upioad vour own piclure file as the image associated with your
community. Click oh Upload a Community Image. Using the flle browser, navigate ic the
Lab helper_files folder and select the ibmiogo.jpy file. This image will also appear on your
homepage.

Onice you are done filling out the Start Community page dlick the Save bution.

Start a Community

Namie

Tens:

tWeb Address: hapsdiconnection swwy.dersos. ibm comismmunitie sicommurite
1 j o
Emer & short name tocustomize the tink. or leswe biank

“Aocess & public - anyone can join

3 Wodersied - paople mus reques io join

O Hesecitied - people myss e invied o join |

Deserimion:

A pantral communily ic 2ssizm el empoyeesin Conneclions

body p

o 8 Commundy ngge | 7 ity Thermne

flaee

IBM World Wide Techricat Szies
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Step 4 After saving your selections you will be at your cormmunity homepage.  Now you can start ,
populating your communify with useful information.. We will start by adding content fo the basic ;
components of a community, the Forums, Bookmarks, and Files. These are located down the center t
of your community page. Locate the Forums section and click Start the First Tople to create a forum
fopic. ¢
1514 Copnections Community of Practioe g i s Somamarmhy | Ssnnn Anjie
 |B% Connaclions ~ Community Descripiion luporiant Bookmarks :
Comnrunity of Poctive H
A ceht 10 essis 2 empiizes iboived in © Suphtighrdey Web posiTos
- HEER
% M%E Forums. E] Z
- 15 Ask = qusmicn, brainmons, @ simply Shire v idess 4
S b Pl T -
« Croarvies: Bookmarks . # :
RecprtUngmes i3 Enate Wnb rREDUETRE will) your SomEnGnTy, ;
Stmius Updatay © ek vep Fers B :
Henshers.
P Files :
Buckmiarke E
Fainr: | H
Fas i L C e e e T I
Henicg B There are nefles forshis canomaniy.
—_—— Shuas an Firm Fas
> Tags ? :
PEFtRgs Y g
Step 5 Youwild now see the Start a Topic creation page. Fill out this page giving the forun title, tags, ) .
and description. Note you also have the option to attach a file which is located on your local computer. i
Once you are finished click the Save buiton. -
£
!
&
i

. CEEER e
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St a fopic

¥ THle:

Disclssion of best practices using ceammunitiss
O fazk this topic 25 & guestion

Tage

Thislopt shouid create discussion around best practices we have experiesnced Uilizing Connactions Communives for i men proiects.
Ary productive comments and ideas srewesicome!

Anachments:

Algchoa File

s SR

Step 6 You havs just créated the first Forum topic. As a member of the community you have several
options to inferact with this Forum post from the options listed directly below this post. You have the
option to reply to this post, edit the information (if you have authority), move this post, lock the topic so
ne one else can alter or add fo it, and pin this topic so you have a quick and convenient way 1o find this
information.

Discussion of best practices using communities

Tlay Z15 PR | TS st skl Beres Tow
This topic should create discussion around gractices we have sxparenced utilizing Connectians
Cemmunities for our own orojects. Any productive corimsm and ideas are welcorse!

Fieply | Edii | Dedete | Mowe | Leek Brde | Pinthis B

Step 7 Select the Community you created, fo navigate back o the community homepage. Ciick on
the name of the community above the Community's logo on the leff hand side,

1BM Waorld Wide Technical Sales
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= IBW Conneclions
Commuiily of Practice

Crrardiaw

Recent Updates

Step 8 Next, add a bookmark to your community by locating the Bookmarks section, located below
the Forums seclion. Click the Add Your First Bookmark link fo get starfed creafing a community
bookmari. .

Beokmarks :

ﬁ Share Wb resources with your community.

Add Your Firsf Fockmark

prr—

Step 9 You will see the Add Bookmark page. Fil out this page, including the URL, name, description,
and any tags you wish {o associate with your new community bookmark, When done click the Save
butfon.

£
i
i
&
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Add Bookmark

*URL mptm';mxbmm;; TUUT T T T e e e T e

*lame:

Crestriptivr:
H

Taps -

Agd to Imporiant Bockmiarks

* Reqlired

Step 1¢ Once the bookmark has been added to your community you will see a confirmation message

at the top of your screen.

£ Tr fookinark hes bosn askied By

Bookmarks
Cormuniy menhsrs can oo ite Dodiiarks 0 Weis sltes of inlere sl to the graun Community mesthers can flag impeelan &

sand o

ilcil Page 1

BN Homepags
Dan HMzawa | Teine S 0PH  Bos v

Llatl

ernarks s hat they

ke

Step 11 Clicking on the More link fo the right of your boolimark entry will provide you with the abiity to
Edit or Delete the bookmark you just created. '

|BM World Wide Technica! Sales.
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& e tookmarls hes been added oyour comunily. -

Bookmarks -

Cammuniy members can contibute heokmarksto¥Web sites of intsrest to the grosp. Cammminiy mernbears can flag mpesant boolanaks sothat they
mang ot

B

& Bowlaragk §

iofl Page 1

Hae

I Homepage

Hormepags for eventhing redated o iShE,

Edit | Deris

Step 12 Navigate back o the home page of the |BM Connections Community of Practice
community. To add a file o your community locate the Files section of your community homepage,
which Is under the Bookmarks section. You will have to dlick Click the Share Your First File.

Fiies ' =

;
H
%
[
i

| Files f Folders ;
i : - H

& There ate no files for fhis community. . : i

Share Your First Fiie

Step 13 You will now ses the Share Files with this Community window. You have several options
for sharing & fite with this cormmunity. The first option you will see on your left menu will be to Browse
Files on My Computer, which allows you to select a local file fo upload, Recent Files will show you a
fist of files you have most recently interacted with. Pinned Files show any files you decided to pin
through connections for quick reference. Using the My Files view will provide a list of the files you
have uploaded yourself into connections. The Shared With Me option aliows you to view files that
other users have marked as sharing with you either through editor or reader access.

Other People's Files option allows you to search users for public access files you can incorporate info
the community. Pinned Folders is similar fo the previous pinned files opticn, as this view shows any
foiders you have pinned. The My Folders option shows you the folder structure you have created or
uploadad for your specific user in Conneclions. Finally, the Shared Folders view is a list of all folders
other users have marked as sharing with you.

For the purposes of this fab we will click the My Files view and share a file this user has already
upleaded to Connections (This wag done during the earlier part of the izb, That file is tbmiog.ipg.
shouid be displayed in the list. Check the file to share and then chick Share Files.

1BM World Wide Technical Sales
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Siae Fileg i My Compdoer | 1 file seleckd ésﬁarcn hese fllc‘s
Recent Files ibmidgojoy:

Pinned Fi

Pabiic Files

Other People’s Fiies
¥ Pinmed Folders
» Rty Folders
F Shared Folders

[C]#dlow sommnunity membersto editthe sel_aczed'fil'es

|

Step 14 Ones your files has been added to the community you will see a confirmation message under
the Files section.

Filas B

! £ 11ie wes siccessfully shared wﬁh this t;i:smmumty '
; . d s

Step 15 Clicking on one of the file names within the Files section, will navigate you to the detailed page
for this specific file. Once on this page users have a number if ways fo interact with the specific file. Al
ihe top of the page near the file name note that you can 'pin' the file, which will cause this file to ba
fisted under your Pinned Files view so you can quickly find this content at a later date. Users can
click the Like link to tag the file and show other users this is something they are interested in. Along
the middle note there are five butions that allow you to manage and control the file. The Download
button allows & user to download the file fo their local computer. The Upload New Version buiton will
launch a window allowing the user o select a file from the local computer {o upload as the newest
version of the file.
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ibmlogo.jpg =

Fublic | Dan Wisass created wiay of B35 PM | Wersion 1 1 5KB (23 KB including a/l versians)

. Commeete 8] | AmmodisFlle Sharing § Wersions (1) ;

H B H = i
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Add | cedmmignh

Step 16 Click the Share button. This wili launch a Share File window. Using this window you can f

share a file with other users andfor communities. Note you have the option to specify i these people ;
will be readers or owners of the file as you add them. Sharing in this way wilt send a nofification into

the activity stream of the selected users. For now you can click the Cancel button o close this

window. . .

;

{

Thisfilgis puhiit: it is alsodn & folder or COIMTGnity. {

{

!

Step 17 Back at the File page cdlick the Add to Folders bulion.  This will open the Add to Folders
window. Here you can add a copy of the specified file fo any folder you have access to, including
folders that are currenfly shared with you. (Depending on the user, there may be no folders fisted.)
Click the Caneel bution to close the window,

H
H
i
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{ Recantly Updated Folders
7 comrsunity fes

™ Allew mambers of the eelecied folders to editthis fe

Step 18 Click the More Actions bufton. You should see a drop down menu with multiple options. The
Stop Following option will keep future activity notifications from showing up in your activity streams.
The Edit Properiies option opens the Edit Properiies window where you can modify the file name,
extension, and description. The Add Comments option opens a comment text box for you to provide
additional commenis about the file that other users will see. The Lock File oplion is a new feature in
Connecfions. This option agllows the file owner fo lock a file so no other users associated with the file
can edit. Click the Lock File option and you will ses a status message appear verifying the file is now
locked. When a file is locked other users associated with the file will see that the file is locked and who
locked the fife. After locking the file once again click the More Actions butfon and now select Unlock
a File. This wili once again unlock the file to allow edis by all associated owrers. You should also see a
status message letting you know the file is now unlocked. Clicking the Give a Copy to Community
option will aflow you to create & copy of the file and add it 1o & specific community. At that ime you
cen edit the file name and any tags associated with the file. Finally , f you select the Move to Trash
option this will move the specified file to the Trash section of the Connections Files application. Moving
a file to frash makes the file unavaflable fo any user who might be associated. The file will only be
moved fo the frash area, but not vet deleied. In order fo completely delete the file the user must
navigate to the trash section of the Files area and confirm the deletion of this file.

{
!
{
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Step 19 The community page left navigation has many useful options to share information with the a
community or navigate through the community. Navigate back to the community homepage. Click on
the Recent Updates option in the left navigation menu and you will see an activity stream of all recent
activity happening within the community. For nstance, Dan Misawa would like fo encourage oibers to ‘
usé the community so he makes a post 1o the community. Enter the message and then click Pest.
L
. . ¢
Recent Updates _ =
. . : i
L
:
i
i_.
{
Recent Updates e

e e P - S ' + -
5 Pleaze help this commmunity get started by sharng information and experiences on best
- practices for using |BK Conections, Thamk Y,

Prest | Clesr
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Regent Undaies _ =

< P SiTecild

Pran Misewa Please help this communily get starked by shariog information
and experisnices on best praciices far using iIBM Connections. Thank Youw

i3 ey el 237 2

Dan Misswa shared the file immisgejpy.

Step 26 Ask your neighbor fo navigate to the IBM Community of Practice Community (Your
community). As a new user to this communily you would like fo join the commurity so she can post
messages, eic.. [n the upper right comer click on Join this Community. A confirmation message is
display welcoming her to the community. Users can also interact with recent activity in various ways
through the embedded exparience window. Clicking-on an update within the Recent Updates aclivity
stream will bring up an embedded expernence window which gives a user more options to provide
feedback fo cther users and the community. For example, you can “Like” & post, re-post to your
followers, and add commens to the selected activity.
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-Step 21 In addition, you can interact with any posts that share files by dlicking that update within the
activity stream and launching the embedded experience window. Here you will have various options o
interact such as ability to “Like” the files, Share the file for vour other followers, Foliow File to keep up
with changes in your activity stream, Comment on the update, and also Preview or Download the
file. Try using a few of these options fo interact with a post.
Recent Ugdams Dan Misasa shaied a file with acommuniy | TdayatB 21 ®
A
% oo pg - !
3 é
L
s Pienss Ralp TS commundy get stars o ahenng 1
And =xpedzanas o hast pracrce s for wsing |EM Sanrecions Thi
{8 Tanpamn 27 A8 - 5
,Ezfar_r; giuarcs shared the Sie iberioag ag : ; - v M GRSTEME ey e YR
: " AR Fmeaw R Komi woasy geng
ISRy pRmsemoleeeiedr SESSGHT I RNNER ’
EEERRR AT ORGSR RN T IR ‘
B oo 52 AM
B _Shéwnsm_mm E K I
s s S KB = :
i
Praert Mivewes added the Eidd 1darrepage bookrark. E bk §

@ fimn fsasa Homepage for sven'thing relates o 1BRL
i

BR ety a0 A ) Commenis (1) Sharim Reoerm Uprses

) Fgid o Cpmnannt
of Ikt (R agtices ¢

of Praelise forur

! Fiasthor Reeds woay a) § 23 ;!-M_ :
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Step 22 Click the Status Updates section in the left navigation community menu. This view will filter
out other types of community interaciion from the aclivity stream and show you only posts that are
classified as status updates. (There may be no siatus updates. This is dependent on the activity done
with the image.) As with.any aclivily stream interaction, in this view you also have the option fo select
an activity posted and bring up the embedded experience window which shows additional options to
interact with & specific post. ’

~ |BM Connections
Community of Pracfice

Dun Misany Plesse help iz somrrunite get startet by sharing irdormaton and -

e PRI —
i ol eipirignces on best pratiioss Tor using IBM Canretfions. Thank Yol
S S s 1 e BB vay at0py S8
; Faed i these siies
Dverview B} Foed i mess st

Recen: Updates

- Status Updates

Mambers

Forums
Bookmarks

Fligs

Step 23 Navigate fo the IBM Connections Commumnity of Practice’ community. Click on the
Members menu selection in the left side communify navigation menu. This will show you a view of all
the current community members and their rofe In the community. This section is the primary area for
community member management. Here you can Add Members, Invite Members, Import Members

fist, and Export Members list.

S5 e AN
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Step 24 Click on the Forums option in the Isft navigation menu, This will tzke you to the Forums area
of the community. This is the same as dlicking the View All fink in the Forums section of the
community homepage. This exclusive Forums navigation view lefs you inferact with communily
Forums and Topics with all the editor options previously mentioned. For example, you can navigate to

a jopic and edit what has been posted, or even lock the fopic so close i from new posis.

* IBR Connettions
Cormmunity of Practice

Rerlics

s Fripcussion of best grsatices tsing
comimmnities
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= Ferums -

Bookmarks
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Metrics

=, Red

Lol Post

Tocdsiy 51106 AN

By T Misarm

Previous | blext

Step 25 Click on the Bookmarks option in the lefi navigation menu. This will bring vou fo the
Bookmarks section of the community. Simifarly you can click the View All link from the Bookmarks
section af the community homepage fo reach this area. This area lefs you add bookmarks fo the
camimuniy, o edit existing community bookmarks.
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Step 26 Click on the Files option in the left navigation menu. This will bring you to the Files secfion of
the commiunity. Alternatively you can click the View All link from the Files section of the community
homepage to reach this area. Here you can manage curent commurity shared files, download files,

and share files and folders with the comrmunity.
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Gommunty User ManacEMENT

- In this section we will explore the activity of managing Users as the coms

Step 1 Navigale to the Members section of your community,

~ 188 Connections KMembers
Community of Praciice e i
bsdwtiaars |
Flagt by
T G e —
Pt —————
e e ews  Jsmenm zocrwe 3 .
R e sk Filisr by 1)
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= Members show: L6340 I Pievious | Hext
Forums o
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Step2  Click on the Add Members button to add a user to the community. On the Add Members
sereen vou have the option {0 add members to the community as individual users or a group of
users. You alssc have ihe oplion fo add these people as Members or Owners. Add a single
user to the community as a member. You can use the fext box on the right to type the person's
name (e.g. gloria) and notice how the type ahead brings up relevant user names. Select the
pop up name ana it will be select to be added. Click the Save bution.

Add Members

Rl
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Add Members

pembers: ! Pecp

Step 3 You will now see a confirmation message fetting you know the user has been added fo the
comrmunity. .

£ You have sucoessfully added the following members 1

Step 4 Click the invite Members button. You will see the invite Members page open with a text box
allowing you o type in a member's name to invite to this community., This text box also
provides type ahead. Typsin a users name (e.g. George Brett) and click the Send
invitations buiton,

vite Members

Wembers:

Step5 - You will now see a confirmation message letting you know the user has been invited to the
community. :

@“Yﬁﬁ s Qﬁcﬁmsfuﬁi%iﬁﬁﬁgdtiﬁa fé-i_iﬂ ng £ _pliﬁ:m"-iﬁ_iééqnjmuﬁi@ _G@?.éi’gé_é_‘f_ﬁﬁ'. :

i
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Step § If you click the Invitations tab in the main Members page you will see a fist of alf pending
invitations. You also have the options to resend or revoke a community invitation fo a user by
clicking the Resend and Revoke tabs respectively.

Members

I-1lofl

Sort by Hamee | Dt neiesd ~

Crearge Hoed
liwwited Teday
Feanmad ] Revoks

Show: 16 |22 {48 | 100

B Feend for Dveiimtions

Gering Tated Action Requlired

Wiy TS that rerEIR Y FESRONES.
it Follesing
Stamis Updates

By Moifications

FiterBy[ail T e
« Action Requivern  §8

a1 invited you e join the 1853 Ooareeticns Dovneasnity of Prasios commusisy.

Saved

& cettral commuity oassis 2l emplovess involved in Copnedlions
Discoees

% Toav m 253 PM
by Page

Step 7 Once a user is sent an invitation an Action Required notification will be shown on their activity
stream. From the Home Connections screen, clicking on the Action Required view will aliow
the user to see the invitation. Hovering your mouse over the invitation will all you to accept or
reject the community invitation. Go shead and click Join this Community.

Step 8 Navigate to the IBM Connections Community of Practice community. From the Members
section of the community you can add large groups of users by importing a member list. Click
the import Members bution. You will be presented with the Import People to the Community
window where you have the option providing several user email addresses or upload a C8V
fite of email addresses. This method allows you fo quickly add a large number of paople fo a
community. This opfion also allows you to add these users as either Members or Owners of
the community with a drop-down box in the Action section of the window.
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Action! & Add peopie to the z:p_mmuniﬁ:‘ ag!} Members 3

© irvite paople fo the corrunity

Peopletolmport & Enter comms-separated email addreszes

L Seiect a CSV filz of il aﬁﬁr&sses

Ng file chozen

Step 9 From the Members section of the community you can alsc chose to export your existing
. owners and members. Click the Export Members button. You will see the Export people from
this Community fo & CSV file window. You can chose to export all user records associated with
this community, or specify only owhers, or only members, by using the corresponding check
box. Once you have made your selection you can click the Export button to create the CSV
file and 'save to vour local computer. This action will create a membership.csv file by default in
your downioads directory. Press Cancel and go back to Cormmunity home page

oy
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Joiming A Commpumty

Step 1 Update the community access for the IBM Connections Community of Practice community from
the user that originally created this community (e.g. Dan Misawa). Go back to the Community
Homepage. in the upper right comer, seiect Community Actions then Edit Community.

Click the radio bution for Moederated, then click Save. This also shows you that you can
change the access from public to moderated after a community was created.

Create Subodmmigniy

St Following this Sommuniy [ Commugns Sctonse

Important Bt &

Edit Community

% Compmenity Prefils © Swus Updaes ‘ Eonms © Fites
3 S5

Edif & Commmanigy %

*ame: '_ - .
Taps B ‘M B

Web Addrassr hpsdfconnectionswssde mas. b .comécom mn nite sicomm nity

Enter & shiort name i cusamizs the Ink, or sase blank,
FACCB S i

T pubtic - BOYDAE CAEN |Oin !

Moderated - peopls mMust reguest to join l Fe

3 Resericted - people must be invited tojogin

Step 2 Ask your neighbor to navigate to public Communites and you'll see the 1BM Connections
s Community of Practice in the list.. As a suggestion, try using the search feature to find the
community, if vou tagged it with fest.  Click on the Comimunity. Nofice that the community is
now a Moderated community by the icon nexd to the community name.
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Step 3 Click the Request to Join this Community bution located in the top right area of the
cormmunity homepage. o : : :

Foliow this Communit g Fequess o doin this Community

Step 4 On the Reqguest Membarship page emer your justification and click the Send bution

Reguest Membership: IBM Connections Community of Practics

Al membership requesss for this communily require approval from s cemmunily swner.

Please tell the cornmunily ewner why you would like tnjoin this community. Click the "Send™ butlen and vour requesiwil be sent

Please alits I'ne to moress this tast conmunity, §am 2 tesuser

Pross ALT O for hedp ;

ST

&3 Your membership request has been sent

« Community Deseription

A centrad commuidty o asaist all employeess involverd in Connections
o= o

Step 5 You will see a confirmation message that your membership request was sent to the community
owners. From the Connections Home, click on Action Reguired. and you will sea the request
1o accept the membership within the the Aclivity Stream.
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EvEnts in & ConnNECTIONS CommuNITY

7 interaction

Step 1 Within the [BM Connections Community of Practice community, click the Comimunity
Actions drop down menu located in the fop right section of the browser window. Select
Customize,

i This Comm unﬂfg

.

Sop Folioeing this Cammuniy Community Asiongs
- Create Subcommuniy

{ Edit Comrmurity
Important B e e

Bk Homepage Hiall Communiy

Leave Community
Members

Delete Comimuaniy

B

Winw S 13 peogia)

Step 2 You will see the Add Content window at the top of your communtty page with a number of
possible widgets you can add te your current community. Click the plus sign next to the
Events selection.

IEM Connections Communiy of Practice Stop Fovreingihis oty § Commeriy Acfionee
et Grotent E’E’E_.L‘.‘.. &

i gp Biog * + g Activities 1w b3

ﬁ Subcommunities % |8 Fesds + ﬁ raadia Cattary -+ & Everzs -

{53 Relaf=d Communities
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Step 3 After selecling Events you will briefly see a status telling you the widget is being added 1o your
community. Once this is done the Events option will change to show Events added. You will i
also see a note stating 1 items added in the upper right comer of the window. Most
importantly, the Events section of the community has now been added to the left navigation - ;
ment of the community site. ' '

= {wperyiow
Recant Li;-aéates <
Satus Undates
Members
Forums
Bookmarks
Files

Evenis

tletics L

Step 4 You can now close the Add Content window by clicking the X in the upper right comer.

Step S tn the main navigation menu on the left of the community page click the newly created Events
option. This will take you to the Evenis page of this community.

3
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Step 6 Get started by creating an event! Click the Create an Event bution. You are presented with
the Create Event page. Provide all necessary information for your event and provide a
description and possible lecation.

Step 7 Be sure to indicate the event for a future date..

Step 8 Note an important option at the bottom of this page. You have a check box for Notify

: ; sommunity members. Put a check mark in this box io expand the page and see a list of users
L with check mark options besids their names to flag for notification of this new svent. The users
selected will get get notifications of this event complete with a custom message you provide in
the Message text field of the page. Be sure to select Your neighbor, e.g. Heather Reeds.

Step 2 Once you have completed the options on this events creation page click the Save button.
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Create Event

* Everd Tille:

Tage &

* Stana: ) mé[f] Alf-day evant
* Ends:

Leoatian:

Diescription:

body

B Notify community rmembars

i1 Gloria Hoor

i Dan Kisawa

Messag&

iHi- | thauahtyou might be imerested in this evant

= Pequind

Step B¢ You will be {aken back te the main Evenis community page where you will see the newly
created event. (Hint, if the event is not displayed, click on the option to switch between display
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past events and upcoming.} Note fo the right of the event you will see arrows pointing down.

Click on the arrows fo expand the details of this evert. You will also see links for editing this
event which include Edit, Delete, and Notify Other people.

Events

Displain .

lofl L Provious | Neg

Bhme Pas Bvents

Happy Howr Brainstorming Session
Tkt 00 PM - 500 PR Createrd by Dan Missen | Created on Tadey £58 BM

Let's irginstorm soine best praciices Connections community ideas over drivks at & locsl happy ho..

Gt | Delein . Moy Dher Peapds

Shew 10 L2k | 9 Hems Jumpie pge | 2 jotl Bredious | Mew

Step 11 From the main Evenis page click on the Calendar View tab, located at the iop of the window.,
The Calendar View will show you a customizable view of events, By clicking on the View drop
down menu located {o the right vou can switch to a view of One Day, Two Days, Five Days,
Week, and Month. '
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Step 12

Step 13

Step 14

Day o - -5 d;zys et m i year O U S B

In the Calendar View you also have the oplion fo create a community event by clicking the
Create and Event bution, located at the fop of the window. By clicking on an event in the
calendar you will highlight the Edit Event and Delete Event buftons. These buttons will allow
you to alter a scheduled event right from the calendar view as needed. Under these buttons
you shouid note the label for the current month being displayed, and armows on either side of
this label. Using all three of these conirols will allow you to move forward or backward by
month, or navigate directly to a specific month, week, or day.

The member {e.g. Dan Misawa) that created the event in the community wilt be notified of the
new event through his Connections activity siream. (Hint, click an Recent Updates within the

comimunity to see the event) Invited members will alse receive an email communication with

the same information.

From Connections Home click on My Nofifications. A community member can click on the
event fink to take them directly to the community Event page. Here they can provide feedback

B R R RN SEERT R
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that they are aftending the event by clicking the Will Atfend bution. Members also have the
option to follow changes {o the event in their activity stream by clicking the Fallow button. Using
the More Actions button also provides the oplion to Notify Other People of this event, or even
Delete or Edit the évent if the user has proper authority. ’

My Notifications

Mz ppdates and cormmnens related my R rorent, ard notificatians you have sent and

receivad.

an Mismes notified youl and 2 others about the commmunity event Happy
Hour Brainstoiraing Sessbon in the IBR Conpecions Tommundy o \
Pracuce coranuniy, '
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This conciudes the Conneclions 4 Features Walk Through lab. Additional information will be added to

this lab to explore mere features of Connections. For more information about Connections 4, be sure fo ¢
check the Connections 4 product wiki
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Ch2 BA Lab Material

In this exercise you will be leveraging the Cognos Mashup Service to access data from
the Cognos platform on the Cloud and integrate with the Google Map service on the
HTML pages located in your machine.

o Map | Seeime
e




Before the exercise, you should examine the reporis on the BI Cloud server

- Open the following URL in Firefox
kttp://(IP to be provide)/ibm/cognos/cgi-bin/cognos.cgi

Login using the following credential.
Namespace: OPENLDAP

Login name; team!
Password: password

Help {3

00S, 200z : : : :
180, Bk foga, ihtm.com and Cognos ars . ¢
trademarks or registared trademarke oF i
Internztionsl Busines Machines Corp. registered in
many jurisdicion: worldwide, Other product and
service namis might be trademarks of IBM or other
SOMPRrieE.
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“branches” report is used to define locations to Google map o ‘
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“branch-detail” report is used to define product details of branch. (input “9901” as the
branch numbey in the prompt page)

e

14,841,278.51
2,771 80458 £409,347.7
1851,373.58 874,099,365 300,100.64
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3,230,7_3052 493478821
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1. Copy CMESGoogleMaps.html you downloaded from Lotus connection to
CAIBM\Cognosl(\webcontent

CHIBMCognes]Cwebcontent

e e ke Modlis
Flle: Folder 12312012 1;
e Folder 12{31{2612 12:14 PM
File Folder 12/31§2012 12:15 PM
File Folder 12(31§2012 12115 PM
Fils Folder 12431/2012 12: 15 PM
File Folder 1203142012 12:11 P
Flle Folder 12£54)2012 12:10 M
File Folder 12731f2012 12:14 PM
Firefox HTML Docu... 123172012 3146 PM
TSeript Script File §/10/2012 4110 AF
Firefax HTML Docy..,  B{10J201Z $:10 AR
S Frefox HTML Dezu..,  BJ1D/201Z 4110 AM
agMessagediormuxsl - %5L Styleshest 62312012 5:19 AM
3 wedsial - : #ML Bocument Bi22f2012 10042 P

2. Right click the CMSGoogleMaps.himl and click “Edit with Notepad++”, then the

following screen will be shown
- o
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3. In order to connect to the BI server, you need to define the gateway.

How to find the gatewav? .
The Gateway you used to access the server in your Firefox is the public gateway to BI
_server. (http://(IP to be provide)_/ibinfc‘ognos/t:gi—bin/g:ognos-cgi)

In order to allow the API to work, vou need a local gateway.

Try open the following URL in your Firefox, it should return the same login pages as the
public gateway :

http://(local IP)/ibmcognos/cgi-bin/cognos.cgi
{For example the local IP can be 192.168.1.1, IP has to be used rather than localhost
for the HTML page to work)

Therefore, define the gatewayURL variable as follow:

I,

var gatewayURL = "http://(local IP)/ibmeognos/cgi-bin/ cognos.cgi";

e >
<rta Rams=YTlewports GopnrEs="anitiel-mraleed.d, pren-—seslsblsenet S
‘B CR- RIS CONLATEL Y COTMARLEY Liwl Fhink ; charan L=BIF -8 3 . o

v bzbn: fprds. Tognle SIe.” e ] {foZaull CRRS Tei="Etyirshoott Tvraeltoetfozet fx
LorOAS Boagle Mep emeciuivies .
<enipn vypantbext): lpr Teisplhaafa 3 o, fues UrersyLh

TS

var neg,

Cusirdue = e 5ol ey, Tofolnggwl) ¢
var gecondes w mew £TOis.nmpa.feoTedard) @

vz wekenienow hrznz() i G .

1 edid marhesCaune R

13 wmr moreCIngeanl; L

vax i

Wiz SuETentNarkerloTred;
£ vmr domedon.
VAT pTSOTERND e
var legindier

oy i .
war GURER - waw SELBLpRequestl) 7
T eaven (&) | . -
s3r L H '
var ohIYER = e AnriveXfyiest{- ool STy
3 mabch e} if .
wy {
wor CoTER » mem ACTITERGSFECT Riix o mifi. FE FTTH)
) cakem (e {




4.
Now you know the location of the report, vou have to define report for the HTML pages.
Search for function start(). Function start() is used to define the location of Google map.
.
!
|
) anctdon snared) { ”
3 :2;3a»rt§ea:'ch?ati~. = g
RpRth = TSENCUmen 5\
- F—Ses:ch?_ﬁt
: oL :‘ia.(-‘a::.; H 2z
;'x.'rjg* gsﬁiv = dn:un&nt.éﬂ;ElEmez_:ﬁy‘I :

if {ob
Lo 2f (aby¥ER.svatuy — 200} {0
! if{ logoecon ¥ { v
{ 11

i, P [

<
£
¥
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Therefore, it will leverage “branch” report.
To define reportSearchPath variable, type as follow:

“var reportSearchPath = "/content/folder] @name="maps'}/report] @name="branches’";

4 -
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i
Then search for function opentnfo(), this function will leverage the “branch-detail” report. '
Please insert reportSearchPath variable with the same syntax as above ) )

;

{

%

'metrersiil bray
markers[i] <lges 5
S {
|
: I
* + reportsierchPach) h
irﬁ&;eﬁai}ix'.stvi A ';
-prng'—assb :i.v', inne, j

' -:Lnfo indow. clﬂs»(?_ G

uYJjXﬂR.DpEn( "CE”" “r 1..:1, me.) L X
ol EHR . Dr.[nzﬁdyﬂl..ﬁ.x:c}.angﬂ = tanLth‘J 2
4F {O3TER. readyStacs e= 3y f /
ERF ) ;unﬁ:zn stetus we EGE} { i
the Ia;fot,%;n ¢
legﬂju[ﬁ\ﬁp, ;

?
Also this page requires auto login. (not recomamended for the best practice)

Define the following variables:

3
nameSpace = “OPENLDAP” [
userpame = “team1”

: = 73 .
password = “password (

i
in the following parts:

: sEripr> {

i

mr outeruvlRL = " ;
i p CRMIDace = i
war wEerkame = “rese
g ['b'd.z FRITE0rd = “'m
val ut:‘ﬂvf;a":.lewa;f'.e'ﬁl- H )

!

%

¢
You can test the webpage by the URL: 3
http://{local ip)ibmeognos/CMSGoogleMaps. himl -
Then you have completed this exercise.

.
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Chapter 3: Tivoli BigFix

Objectives

In this exercise, we will learn:
e  Review response from BigFIx server
e Perform web service request from Worklight to BigFix Server

e  Parsing the result and integrate with mobile app

Exercises

1. Open a Mozilla Firefox browser, and then go to

hittp:/ /hiafix:8089 fel-bin/IEMA.cal. The following screen is géz;erated:

— <TieTio-
«UprpmterNaras-BFE 1 SVR<Conrp ister Az
IR nsnine Yes M B Hpraing>
<SecCempliance>Yes</SecConmydiance>
</BipEic-

IBM Software Group
Prepared by Eric Chan 1 January 12, 2013
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2. Let’s make the Worklight enable to communicate with the BigFix serven

First, create an HTTP Adapter in the Worklight Project. Find the Workiight

button a- click the down arrow. Then select “Worklight Adapter”.

¢ Worklight Project

o

| Worklight Hybrid Application
: | Worklight inner Application

] Workdight Shell Component
- [ worklight Native API
GE Worklight Erwironment

| [ Worldight Application Skin

3. Choose the currént project (i.e. BigFixTraining) in the field “Project name”
and choose “HTTP Adapter” for the Adapter Type. Enter a name for the
adapter; here we will use “BigFixddapter”.

E#

Workiight Adapter

Lreate 2 new adapted.

HTTP Adapter ¥

BigFixAcapter

IBM Software Group
Prepared by Eric Chan 2 January 12,2013
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4, Configure the adapter with the XML file. Open “BigFixAdapterxml’.

¥ i adarters
¥ O Bighinldapter

o

5. Define the connectivity settings as follows:
- protocol: http
i - domain: bigfix
- por“t: 8089

Frp i HT TP oo HionPol icyType ™

<tocalonsiraints maxConcurrentfonnectionsPertlodes "2 /4
wf ot vl by

‘ 6. Declare adapter procedures. Remove all pre-defined procedures and define

a new procedure called “getServerStatus”.

. 7 wonnrEiight. o fogrotion”
i xins thitns ’“hfip Al worklight, resintegrotion hiis s

«é@&ﬁ?@y&ﬁﬁ&ﬁEigFixﬁdﬂpt?Pt}éi&?mu?Qﬁﬁﬂa
<arzeription-BighixAdopter</iescriptions

conneackivitys

| sepmnackionPolicy wsirhype="REtn BT onneeiianPel inyType "
i sprotoccizhitp < erolocols

edmairehiof e/ donsins.

) sporl-BiEDa fporis

| <fronnertionPolicys

] «lpedlonstraint s maxConcurrentlonnectionsPerliode="2" /»

; sfeormectivity

wfw? ﬁé@ptew\

IBM Software Group
Prepared by Eric Chan 3 Ianuary 12,2013
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7. Implement procedures in the JavaScript file. Open “BigFixAdapter-impljs”.

A Q%; aﬁapa‘;ﬂ rs

ézg} fi Eteg’ﬁsﬁ %5

8. Remove all code and insert the following:

function getServerStatus() |
var input = {
mathod : Tgei’,

returnedContentType : Tzml’,

path : Ycgi~b

~

return WL.Server.invcokeHttp{input}

}

9. Now, try if the adapter can retrieve response from BigFix Server.

& ﬁ;WLS:mer L iy A
New .
Go ko

N
Ay

. . adopter:; 'Biglicidaphes’,
Open in New Window procedure: ‘gesiberverttotos’,

Show in LHW ¥ | poroceters: [3

Copy BC
Copy Qualified Name fons =
onSuccess: getSuccess,
TEpbaFTt ok Paste Y | onfoilure: getFailure
PR g Dejete ®
FEeams . o i
Build Path » nt. lavekeProcedurelinvocetionliota, eptions)i
Refactor BT ¥
. i tiuccess(data} {
g Import... tn 11 tdota.fovocotionResutt |1 ddeta. invocat
24 EXport.. wEr‘r‘or%‘essage( Toutd not retrieve news'l
=4 '7 2 Refresh g b dato. imeocationfiesult  E{afixg
=g . . :
& Assign Working Sets... ults.BBRunning == *VYes' 88 results.SecComplic
B . #’bsf&vfo”teﬂt’) htﬂEC‘Se“uef %1 o4 results.lon

4% 1 Deploy Worklight Adapter
S 2 Invoke Workiight Back-end Servic

Freﬁie As
Team L4

Compare With ¥ | Run Configurations.
& @ bin ¢ Restore from Local History...
Erromponeml Caores =
ks -
L Properties E-3
iBM Software Group

Prepared by Eric Chan ‘ 4 January 12, 2013
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10. Choose the corresponding project name (i.e. “BigFixTraining™) and adapter

name (i.e. “BigFixAdapter”). Choose "getServerStatus” as the procedure name

to invoke. Keep parameters empty and click “Run”.

Edit configuration and fauneh,

Prepared by Eric Chan 5

11. The result should be somehow in the following format.

1 BarTrsicing BigFTrabing s " {E BipFceetapteran | ) Bofudapter-impl e

Invocation Resalt of procedure: 'geiServerStatas’ from the Waordight Server:

‘ “BigFiK"™: |

| "Corepaterfiame”; "RFEISVE",

“GERunming”: Yes™,
i N =ecCompilance™ ™es"

IBM Software Group

January 12, 2013
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12. Then you can go on to integrate the results inte the mobile application, The

application layout interface has already been provided. You should write

code to display the results. Open “BigFixTraining js".

¥ 53 anps
w gg, BigFluTraining
# s andraid
T e COETIIRON
¥ Eboss
P B Images
T

5] jnuery-1.8.3.minjs
% jouergamnobile-1.2.0.min
@ SRS . |5

E BigFixTraining. himi

13. Inthe getServerStatus{] function, create an invocationData object for the

procedure call with the following format:

wrar invecationData = {

zdapter:

procedurs: ‘pIscsd

parameters: []

Fill in corresponding information for the procedure call.

i4. Create an options chiect to define success and failure handlers.

var opticons = {
cnSuccess: getSuccess,

onFailure: getFailurs

15. Create a Worldight Procedure cail.

WL. invokeProcedure {invocationData, optionsj;
1BM Software Group
Prepared by Eric Chan 6 Janvary 12, 2013
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16, In the getSuccess{data) function, write code to display conditional content

depending on the result from BigFix server. The returned BigFix object has

been stored to a variable called result. You can access object properties

Mo

ComputerName, DERunning and SecCompliance by calling
‘ ‘ result.ComputerName, result. DBERunning and result.SecCompliance

respectively. The following is an example to display the sentence “The quick

brown fox jumps over the lazy dog”;

win foX damps over the lazy i

17. Now you can test the application.

i
i

IBM Software Group :
Prepared by Eric Chan 7 January 12,2013
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IBM Software :

Lab1  Getting Started with IBM Worklight

In this lab you wiil develop a basic mobile app using the 1BM Worklight Studio development enviranment.

You will use cross platform technigues such as HTMLS, CSS3, JavaScript and the jQuery Mobile . - | peteted: jQuery ) {
framework. The app you will develop and uss throughout this Lab is called Mysurance and xts purpose s . - - { Deletad; PoT 14

o heip create an insurance claim In case you have a car accident, and aiso to help you out while at the .
a@:t:ldant scane, Beiow are some scresnshots from the fully developed appiication:

A samgle application bulk on the
IBM Warkiight Platferm using
HTRILS, CSS3, JavaScript, and the
Doje Mobils 1 rk

In this lab vou will build a simplified version of these two views in the rich page editor.

prE——

Upon completion of this exercise you should have gained basic understanding of
o How to create a Worklight project and a Worklight application in Worklight Studio
o How to build and deploy a Workiight application to the test server in the Worklight Studio

o Howto use the Moblle De\rlce Simulator to preview and test an application from the Worklight
Studio

o How io create Workdight Envirchments for platforms such as Androjd, Prone, ete
¢ How fo use the Rich Page Edgilor to add Ul elements o an application

You should possess basic knowledge of HTML, CSS and JavaScript. Familiarity with the Ecilpse platform
is & pius, but not required.

Page 4 Getting Started with IBM Worklight




-

IBM Sciware

1.1 Start the Worklight Studio

This lab assumes that you have obtained and started the corresponding ViMWare image. In the image
y6u will launch Eclipse with the Worklight Studic looling and then create a project for the Mysurance app.

_ 1. Start Worklight Studio
a.  Inthe Worklight folder double-click the Worklight Studio icon.

 AppCenter 6/2U[2017 143 AM
£ Jetty Warkight Consols 7HB{2012 8:0F PM
¥ Worldight Corsole 6iZ1jZ01Z 1:12 AM
T start ferty. hat THTHOZ B0 P
LeistertiMysuranceBackend.bat  7{18{2012 7143 PM
Sstopliberty.hat {72012 E:04 PW
@s{npfﬂysuranceea&end.bat 7i20{2012 10:34 AM
- H 7i20{2012 12:03 PM

b.  Onthe Workspace Launcher dialog accept the default workspace path
C:\Worldightlablworkspace and click OK.

sefect a workspace

Edipae stores your projocts & 8 Foider called & workspace.
Chocse = wirlspace Folder ba use for this szssion.

c. [ you receive an Eclipse Welcome Screen, dismiss if by closing the Welcome tab.

Page 5
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1.2

Mo

Create the Mysurance project and application

Create Mysurance project

__a  Swilch to the Design perspechive by dlicking the Open perspoctives icon and selecting
Other » Design,

__ b, Select File > New > Workii‘ght Project

Page B

Getiing Staried with 1BM Worklight
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Ertter Mysurance as the project name, keep the default Project Templates sefection for
Hybrid Application and click Next.

Workhight Project ' : i
Crente a new Worklight project 4

lystrance

Page 7

Worklight Praject
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IBM Software

The Hybrid Application pane! will surface noting that you have not specified an
Application name. Enter Mysurance for the Application Nams, check the box to Add
jQuery Mobile, enter the Location, check the jmages folder, 0SS and JavaScript fies
of iQuery Mobils, Le, jguery.mobile-1.2.0.c88 and jgueryv.mobile.1.2.0.js. Click Finish

Hybrid Appbestion
Configure the Rybrid Spolication that well bk created alovg with the Workfight nrojedt.

images .
guery.ancbile-1.2.0.055

sicry.mobiie, Structiure-1,2.8.055

guenvnbiltstructure- 3.2.0.mincss

The appiication template will be populated and the application-descriptor.xmi file will
open by default. Application characteristics such as authentication and server URL are
managed in this file. We can leave it at its defaults for now, while we investigate the
parts of a Worklight project and application.

Page 8
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__fInthe Pryject Explorer pane, expand the Mysuranece project. Review the folder structure

that has been created.

B

5 Project Explorer 33 [

% B8 Mysurance
7 Do WL Server Library

b 2 senvenave

» =% JevaScript Resources
& adapters
& #5 apps
& G bin
& components
boigm Setuver

» Zh IRE System Libwary {jie?}

0 Inthe Project Explorer, expand the apps folder then the apps > Mysurance foider and
the apps > Mysurance > common folder that were created by the new appiication wizard.

IBM Softwars

WL Server Library
Contains the Warklight APE jar file
serverffava

Location for server-side java code in java-base adapters
(advanced)

JRE System Library

Contains the JRE used in this project

JavaScript Resources

Contains the project’s JavaScript classes content

adapiers:

Conains the project’s adapters (used for backend
conhectivity)

apps:

Contains the projasct’s appiications

ksira:

Locatior: for build artifacts (wiapp files) that are depioyed
to & Worklight server

components .

Contains shell appiication components {advanced)

Server . .

Confains configuration files and exdension locations for
thae embedded Worklight fest server

2, JRE System Lt
B JavaScript Rest
e adapte s '

Deaisted

Defgted: dojof
Gontaing the Doja Taolkit JavaBaript
sowcey

Page 9
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i Project Explorer 2§

s W Server Librane
b @ serverfjave
# @b JRE Systern Library [jrs7
i+ Bk JavaScript Resources

& adapters
a 5 apps

2 &% Mysurance

& % common
4 G ooss

B Mysurance.css

i % jqueryimobila-12.0
F=-yH '
» B initOptions.s
5 B messagess
5 B Mysurence,js
B Mysurancedml
b E Jegal
e application-descripterxm!

& = hin

&2 compaonents

commeon: the default ‘environment’ that geis
created for an application.

css: Mysurance.css - the main application
CSS file, reset.css — brings ali rendering
engines to one common ground.

images: Default images for the common
environment.

js: Mysurance.js — the main JavaScript file
for the app. messages.js — JSON object
holding ail'-app messages, in#Cptions.js —
init options for the app.

Mysurance.htm!: The main application himi
file, Apptication can have muttiple himl files

legak: All legal related documents.

application-descriptoraonl: Application’s
meta data {securily config, server uri, efc...)

. Open the application-descriptorxmi file, If not aiready opened. Swiich to the Source
tab. The following section specifies the application name, deseription and authar's name
fo be displayed in the Worklight Console.

Page 10 ' " Gefting Started with [BM Workiight
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[em—

- 5 opplicstion-deseripraroml 2
B < ;

P ——

Licensed Materials - Property of IBM

5725592 () Copyright IBM [grp. 2086, 3815, Rights Ressrved.

8 Govarnment (Fers Restricted Rights - Use, duplicetion or
dizclosure restricted by G54 ADP Schedule Contrect with IBM fgrp. --»

<iee Artribute "I8Y must be ddepticel to spalicabion folde name -->
capplication Id="Mysurence” plaifomversion="%, 8. .57
sanlns="htip:/fume  workLi gre. confapplicoti on-descriptor™
wning sesi="http: /. w3, org/ 2801 (XML Schene-instommce™

Deleted: <#>The following seclivn

% speckies suthenlication details. This

/| indicales whether ant when the app

;| requires ssers to authenticate.

+ | Possible values include; ]

* | never. Users are nevet recuired o
authenticala§

: onStartup: Lsers are required to

| authenticale before usig the appT

l onDemand: The app will trigger iogin
process I the developer tiggers it
explicitly, and when il determines that
authentication & requirec §

<displayKeneoMysuranced/displaviismes
wderrriptionsHysyrances fdeseriprinn

<avthor>

<nameapplication”s author</ names
<amsilsapplication euthor's e-mailc/emailis
copyrighi>lopyright My Company</ropyrights

i

<usage reguirefict

. The worklightRootURL, is io be used as the root URL in generated mabile applications. '1

. N len
: Hntomment he
| capthentt cati
B wigvive ¢
. 5B application- desoripiaromt % ; =/ Guthertizat
i —
é e

=Usage reguty
SUSHEE rEguiT

orklightbarverfootial >
ostname} ;8258</ worklightServerfiactUaL >

{43 {larel, T

5
g locel, IFfdaress? 15080 ¢ werk L ight Server focturL >

j.____Environmant specific information wil! be inserted automatically as hew ‘environments’ are ™
added fo the project. You can cbserve this change as environments are added during )
later portions. of the lab. '

i Halotarf
Formatted: Bullets and Numbering ]

Page i1
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~
B wpplication-descriproraenl 1% § ;] i
TS S ) i condrnid wet
cantireid sarsion=™1.6" ; Bereae
Uncpgmant and update push sender ID In order To use push notificetions for azndroid h es,-s—wshiﬁ
<pushlender ey "heyiest” senderld="senderIdTest™ /> : droid
</sndrate> ¢ «fondroids
i S
' Vanp i notion
R T S R 5 e Deleted: P
T e G G OQ O DU g . Deiéteﬂ:hddiogicmhandlea
2. Addlogictofixthe Query Mobllebug, e gg\:‘;mn fallure with e Worklight
- o
_a. -Inthe Project Explorer, iocate and open the Mysuranee.ls file under Mysurance > apps .. - { Deleted: Mysurancehtml )
> Mysurange > common_> is
i Mysuranos If
. . - & -mh W Server Libr) §
i BeF i Tratning BigF Train gandrpid B serveriova | |
¥ g Mymurance % -8 JRE ystem Lh
By WA Server Library L ¥ devaSoript Pes f
b B sprveriiava : adapters !
b el IBE Systons Hbroey o 58 8 MacQEX & ! i
B m baamSerit Recources
I3 agdapters .
b apips
¥ I5 Mysurance
¥ S COMmmon
B Brse .
¥ Enimages :
¥ E jnuergabile-1L2.0 i
vk
¥ B inieOntions js : )
: -3 componentys 1
dejo %
T -fag sarver ®
" ;gflegal . Peleted: During the runtims of an B
51 application-desoriptovaomi . | application, the main HTML docusment | |
¥ Fabin +,"| cannat be replaced by another HTML | :
- ! dotument, The Workiight Clent ¢
{ componEnis ./ | framework iniialization is boun( T3y
& B server L . { Formatted: Bullets and Numnbering ] ;
et e e e e d s [ orenatads Fonts Conrler J r
b Aferiheiine "’/ Commen initiaslizaticon code goes here’, enler ¥ .| Formatted: Font: Courler ]

"8 {‘#content . resize ()" (without aucte) The resuiting gode should look iike this:

»

Y. | SeComnectionFailure” (without

]

Dateted: |n the inif maethod, enter
~timeout: 2000,
onCornectionfellure:

.+ | the quote} inside. the onloat me 23

Page 12
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FPerform a build of the work that you have completed so far,

_a

|BM Software

#%3 - Frogecky of 138
b I8 forp. I8, ALY, ALD Eighie Ruserved,
-{né ﬂm?ﬁta - s :’o‘;umthr ar

S

A7 Borklighs creses with the Juery 1.3.1 Fromswerd bundiod dxavde. IT you das noi wont i¢ use ii, dlemse o
Fhwindow. 3w window Jhumy o WLEL

 fumetiin Wi (smmandai 003

staried in offline woely o defined by « consectfinbiarbup peaprrky it todilbtiond. |z
¢ cemmtiooiting wibh NuprkiSenl Server you aced to eithen:

2. "smgs ofsgred it "LQ‘ praperiy in fsdillotions, js o trus,
This wl% ..a '] Frampanrk nobasdionily athenpy bo conment
Kepgs brg o « this may incrwose arpiioetion shari-up Lime.

o Bakidalh

Barver sm b oper

skiishl Server in reguived
» WL i dent aotheds thed
afuilure o6l Hank funoblons &

Z Use Wi.Chremt.cannetU{D A1 ante cotrectivity to o
YThig ARY aeads ie zatbed anne. hefare any @
Doy forget bo epedify myd issismest onluccess gad

O HM{ ol

R S SR

<7 Cemmon fnitislization rode goms here
${ froneent Y. reaizeld;)

e

Save the Mvsurance is file.

Right-click the Mysurance application and select Run As > Build AH and Deploy.

Page 13

Deleted: g

<body

1 onload="WL.Client .init{{ tim
;| mout:2000 |
optenmactionFailura;
dolonnectionFaiiura )}
id="content™ style="display:
; | none">%

Use above or Snippat #1 trom the
atcompanying labi-snippets.ixi file
for cut & paste.§

¢ | The WL.Cliart can aacapt a b
of paraimeters. First, we set the
sonhesfion timeout value i be 2

. | seconds, Secondly, fo add

+ | connectivity faliure defection in the init
* | method, we added
onConnectionFailure propery in
the ontoad method and specified a-
callback functionh named
doCornectionFailure to be
invoked [n case conneciivity fails.

{ Formatted: Indent: First gz O

ametn chosszie "t
Sa tmes Cirise

e 15/|
eI,
toSrceTIS:

Deleted:

=g=Expand tne commen then js
foider, open the Mysurance.}s file,
¢ | This is the application’s main
: | JavaScript file. it contains the
i | wiCommoninit{) funclion that wilt be

| tvoked aulomatically oace the
Worklighl framework inifialization
't completes. You can add your
| application’s initialization code 37

[31
(Fcrmatted: Buliets and Humbenng ]
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s Capy GQualified Rame -
& Paste

£ Delets

% Bemows frovn Conte
Busitd Path

Mave...

Rename. ..

aey bmipori.
i Erport...

&1 Refrach
Validate
Show in Femote Systems uiew

Run Canfigurattons...

The Build and Deploy step will publish your appfication to an embedded test server within
eclipse, where we can preview and test as part of the development life-cycle.

b.  Verify that the buiid process and that the deployment to Worklight server was successful
by examining the log output in the Conscle view.

2018-07-03 151) St}ar:ing bulld prosesst applicetion 'Hysurance', all enviromewts
20120703 55} Aprlicetion ‘Mysurence' with all enxvironments bulld Zinished
2015-0G7-03 20:22:55] deploving spplication ‘Hysurance® mith sll eavirommencs teo Worklight Server...
20:22:591 Deyxloyed app ‘Mysturasce—common' suscessfully on Forklight Seryver

20:23:003F &

If the console is not displayed, open it with Window > Show view > Console.

Use Window > Use the conscle icon %) to switch between the various consoles if
necessary, until you find the Worklight Conscle.

Page 14 - _' Getling Started with 1BM Worklight
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Preview common resources in Mobile Browser Simulator

1. Right-click on either the common folder {to run the common resource web app) or the
mysirance. himi file within the common folder and select Run as > Preview (use the first
preview aption in the menu)

z2vaSeripl Rezcurees

?gﬁterﬁ window.$ ~ WLI0
| T Mysonanee function & Commonlaitd{

T MpSsrmon oMM MDD
«:@’ Mysoranpe-customization ey
5 tomponents

¢ Bersove fom Dondext
4 Bark s Langmark
Buikd Path

Mowve...

Rename...

gus Irport...
el Export...

& Refresk

Validate
Skow in Remote Systems view

Debug As
Profile As
Team
Comparg With
Repface With
Sowrce

Properiles

Eysirance S8 =

A7 Srriiiahy cmses with the Jlcery fraxesurk busdied inside.

New
Show in TEW
Onan
Open Witk
apphicatan-desoipr on
1l -G ofo.prnpeaies gﬁ Copy
; bnsdig - 2 Copy Qualified Kame
¥ Erbin & Pagte
@ FynLeahoeaval x Dai EE -

/¢ Uommen imitislizelive code goes Pera

FETA rane seveer 14 nab meitohis don't fell bub run in discopmeschud wmods

* 51 Warklight saever uneveilable, swwiing
»
F3
1 3

®C |

3% ¥ Run on Server GYXR
£82 Build AH and Deploy

1 DOH Rumner

L

Run Canfigurations.

28l

Mysurance application.

2.  Anew external browser window will cpen with the Mobile Browser Simulator rendering our

For this fab, we have configured eclipse fo use an extemnal web browser (Chreme), which opens
tha Mobile Browser Simulator in a browser window cutslde of eclipse. Using an external browser
gives freedom to choose your rendering browser, access to advanced debugging features like
Web Inspector in Ghrome or Firebug with Firefox, and access 1o internet settings, cache and

history that zre not available when running with the internal browser setting in Eclivse (see

Window > Preferences > General > Web Browser for this setiing).

Page 15
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As this application has no device characteristics yet, a simple, moblle browser view is rendered * .4 Deleted! un-slyied )
with no device configuration options. : e

coathashEI B cansole/

Congraiulations! You are previewing vour first hiallo world-like application develobed using Worklight

P — P

PR
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1.4 Exploring Worlkdight Environments

An environment is a mobile, desktop, or web platform capable of displaying web-based

applications, such as the Apple iPhone, Androld phones, Blackbserry, Windows Phone and

Windows 8. In this section you will create environments fo provide suppart for iPhone, Android
+ and Mobile Web. - ’

_ 1. CGreating the Worklight Environments for the Mysurance application

__a inthe Profect Ekp!orer select the Mysuranee application (in the /Mysurancefapps folder).
Ir; the right click menu select New > Workdight Environment.

& Myswrance.htm! I3 S

atstichieg

SREREY
<mELe charsst="uff-47 /»
CIELe NENS=Friéwport™ content= "wic

__b.Inthe Workiigh! Environment dialog, select iPhone, Android phones and tablets, and
Kobile web app, then click Finish.

Page 17
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Nate: in previous versions of the VMware image, we have seen an assertion failure here. I you

see this, please re-try.

c.  Observe tha Consofe window, nofice that the messages about the environments that you
have just chosen.

citagnt L onspie

S[ZH12-86-14 18:34:457 Environment
F{TA12-BA-44 1D,
[2012-96-14 191341417 Environment
A[2012-88-14 19:34:35] Starting au
20170618 19154108
E[ZNE-BE-14 F5:34:

‘i%hene' wos crevted,
=457 Envirooment “Hobilc wel opp' wos o
Android phones and wos erooted.

d process: oppiicotisn ‘Mysuronce', cnvironsents [izhone, mab!iewshopn, osdroid]
SR enineeain Y wne darmardad

Syrurcace | with onvicomacts lishene, snotimmbopn, andeoid) bt id fomshed £

_ 4 Inthe Package Expiorer, observe that there are now additiona! folders created under the

RMysurance application foider.

Page 18
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¥ SELWL Server tibrary

B (0 semver Taa . .

Byl R Systar Lilrary Sava §F € (008 X Defawd |

¥ 25 JawaSeript ftesoprens -
Ld-atlaplers .

hiiid~dojo.praneries
i buiid-dajo.sont
g Ein
R compGrents
e dojt

1BM Software

The new environment's resources wiil
have the following relationship with the
COMMGN resources;

= [mages - override the common
images in case both share the same
name :

s  ess - extend andfor override the
common G35 files

s js - exiends the common application
instance JS cbject (The environment
class extends the commen app class)

+ HTML - override the common HTML
code in case both share the samea
name

« native: conizgins environment spedific
generated application code

Quick review of the native folder for specific environments

_ & Android native foider

{3 Mysimance
¥ @&Mm{é
¥ {Eyess

# mehin
b fxgen
> ialibs
b tteres

S¥C
AndeoicManifestoumd
i nrofeceproperies

¥ @ nativeResources

The native folder under android

containg automatically
generated android application
code that Is imported into the
eclinss workspacs as an
Androld Project during the Buiid
and Daploy step (later).

it is not recommended to edit ﬁlés

under the assets folder, as
each time the application is built
they are regenerated.

Page 19
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b

““a* BB Rysurance
f Eandrold

¥ B nztive

& Hp nativeBesourcas
¥ 55 packige

iPhone folders'

# EClasses
e Cordove Jrarnivori
¥ S MysurmnoeMysranoehhone. oo
¥ {5 Rescurces
¥ g Senmes. busdie
¥ G WorkBohesDyg
B2 buildtire sk
EContiova, plist
B Beritienmenss -Debugplist
£3 Ertitiements-Reiease slist

* B MysuranceMysurancelgiione_Frefty.
B3 Mysurancetiysurancelphone-info.

3. Build and deploy all environments

The native folder under iphone
centains auiomatically generated
iphone app code

The package folder undsr iphone
contains a packaged (zippsd)
application

it is not recommendsd to edit files
under native/www folder, as each time
the application is built they are
regenerated

__a. Right-click the Mysurance application and seiect Run As > Build All and Deploy.
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<iri T eofysyrange e iile

klyeiias =il rel "shortivt {oon® kref- oges Fovicor, pre® A
 Eandroid ; o w iren” breF«"icoges/oppie-totch-icen. ong
o : . E - rofs"csnfreset. csx” 2
rgis _C.o Into - " Shefe s sarence.ces’ Fa .
B - i Showin W # Lyt Limesut: 2R, anCemmectionfeiloee: :
# 5 aattive E—— :
¥ §poniethacResittes | ¢ i Copy BT : frara -n
b - ramaon i B Cooy Qualified Name
¥ [ iphone o Pagtp sey e Fatads ripts
¥ GSess § = £, 35" sripiy
gimxges % Delete o e g it
* s 5 olemeve from Condext U |
® [ aattisr i Build Path W E
b g Closses | I Mowe... :
b {5 Cordova frassewerk i Rename... w25
¥ - Mysurangeblpsusncelphunexc: - :
# Gi-Rescurces i by lmport.,
7 # i betinge bundie i 3 Fxport...
® i WarkdighsSDK . d
® Gy i & Refrech F5 5
s truilurime. st L
5 Corsovz.atist Validate
G Ensidementy-Debug.piis: Show in Remote Systems view
e Entitdomerts-Rebrase, plist :
T
. ; ug As
surincettysuRncalnione, P .
T el Profile A5

[201z-04-25
rzo1z-0%-£$
fEoiE-D4-2€
[20t2-04-26

12012-D8-26 %

Team
Cevevirers Wikh

Srarting build procuss: =pp ioh 'Hysvrazmce', T EE LR
Project 'HysuranceMpsuramceindreid’ wat imported.
Lyplitetion ‘Hyswrance' with il enviromeents buiid finished

Deployiny applicetion 'Rysurante’ with ell emvaicomeerts to Worklight Zesver...
Lpnliceation ‘dyswrance’ deploged suscessfully vitnh ai) envirconments

_ & Observe that the Native Android project has been created and imported into Eclipse

workspace.

This is an example of IBM Worklight's tight integration with the device SDKs. Because the
Android SDK'is Eclipse-enabled, Workiight Is able lo immediately generate an Android
Project i the Eclipse workspace {same for BlackBerry). For other platforms, Worklight
wili launch the respective non-Eciipse tooling and provide a project in that tool's format for
completion (eg. Xcode).
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¥ gEapps
+F gg,m;am:e :
b SR android
¥ Feonmmnn
© B phene
{5 legal : ﬁ
# [ mobilenbapp ! N i
M B application-tescriptoramil ‘
build-dojo.properting
bulid~dojo.xmt
b e b
{
¥ R gen foenarased Jova Fius) £
b o Android 2.2 g )
¥ 2% Android Dependencies §i§
¥ i
|
g
§ ;
Arlroiditanifest ot B %
B prejectproperses E% H
We wili add some more Interesting conient in the next section before previewing the environment-specific f
variations of the application.
:
£
i
i
i
|
{
i
i
]
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1.5 Enhanéing the Mysurance application with visual content

In this part of the Lab, we are going o continue developing cur Mysurance application with the new Rich
Page Editor, added in Warklight 5.0

_41.  Review the content you will build - two Mysurance appllcatlon views

_a The Ma in view and Profile view of the Mysurance appixcatlcn that will be bwlt in this lab
are shown below:

A sarpie application builf on the IBM
Worktight Platform, using FTHLS,

C8583, JavaSeript and the qu
Bobile framework, -

The Main view consists of g jQuery Mobile page, with 2 header, a navigation butfon fo go to the | -
o | Deleted:
| peleted:

Profile view, and soms sample text.

The profile view is also built or: a jQuery Mobiie page, and contains a header,
button to return to the Main view, and a button to use for launching 8 pop-up.

~

2. Prepare Eclipse for Rich Page Editor development by opening the appropriate Eciipse Views,

Ensure that you have both the Paletie and Mobile Navigation tabs visible for use with the Ru.j:n o

Page Editor. We will use Mobile Navigation to manipulate and navi gate betwaan the Pags View
in Mysurance.html, and the Palette will allow us to drag wsuai siements onto the page.

'Page 23

anavigation J -

E Deletad:

w

dajox.mabile ScroliableVie

Header

dejox.mobile.ScrollabieVie

" | peleled:

SOV L NUVR. N | W

Header

1 beleted:

etlipse }

. | Deleted:

Views

- -{ Deleted:

Views

| Defetad:

A

ScrollableViews
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¥ 5 love Srowsing

b BipjavaSeript

¥ {5 favaServer Fates
¥ Ph

7% JavaServer Faces
ras]

Plug-in Jevelopmer
Fo- Remoke Systems:

# ¥ Rdigration 3 .
&5 Plap-in Develtpment :
B o Server : !
¥ G Team

Tracer {or OpenlE £S5

- 5% Progress

=
: iﬁ. Projest Explorer
3 Propecties

Srippets ' ;

i
¢
i
;
i
1
¢
:
oymi PP 'Eymuraare-iphkone-1.00 su:‘: )
beplioyad Bpp

Z022-Q7-f% BLi0E:523 kpplicatien E.
(You can place the tabs in whichever way seems most efficient to you) ;
. ;
-3, Openthe file Mysurance.html into the editor if it's not already opened. ;
. { Deteted: ScrollableView T

-4 Addafieader to the Mysurance himi page. o . _ s
i
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applization are bufli an views. For
this appiication we are using
dojox.mobile.ScrollableVisws, which

1BW Software | Deleted: “Pages” in 2 moble ‘

: dojo visw widgets that
Drag the Header widget from the [uery Mobile Widgets section of the palette info the design | | S Sone. Enure thatte
tab-of theeditor, in the<wdiv dafa=role="page® ~id="page"> sectionofthe- - ~- -~~~ - - --% Mysurance iml file i3 the actve fle in
Mysurance himl file hefore the <6-~- Satasrotex vonisoh ™ gtvle 1:mx 3 - ?~ e edilor pane. and that the dg”
_ section, ) R e —— ! {oeteeem StrolfableView
I . - . . . ) s ~_1Deiemd. Dojo
[ " { pelsted; <rosy>
"1 Formathed: Font: Courier
o an_nhaned: Font: (oorer
| ket
1
! : :
: B Fleld Container : )
L Fovter ; ’ i
i
} ) i} bt ,
“ A4 tink
, ot e e (B spirt¥hesiDatePicker
J : 59 Mysurance.hml 3% B spinihive! TimaPickes
\'i E g" storeCarousel
}Smﬁaw
{ W
fnsert inte Page
{ ‘sage’ above
Contemt
] ;
i 1
{
!
E 5 Properties 33%“%
i
! .
{

Page 25

[r——



IBM Software
o . Be_Jeber.!: Complete e 'Creale 2 e

5  ModiytheHIMicodeofthepageasfoliows, . __._...° ;;:Ve?"w Moblie Scrolladle View' |
_2a Changethe id atirbute of the page view from "pace” to "mainView’. . DeletestEar J

. | Defeted: 16 Jf

b [Change the heading label from "Header” to "Mysurange™., T Font: Coutier )4

) { peteted: fieid )

2 ¢ Remove the defaull "Mysurance” text that now sits below the page <aivs by deleting if ™ ———
B ) beteted: and change the defauit

namie

J
*| Deleted: viewo |
)

At t@emﬂ: of

"', [ Detetad: Check Set as default view -
++* | checkhox i
LR ;
+| Formatted I8l
‘| Formatted: Font: Courier )

Defgted: Select the include y
heading checkbox g i
<#-Enfer Mysurance as the heading £
tabel § CoEL

g e——ry

e R TR R R PR T,
<iink rol="Siyiesfieet® heels "rse/ysurance. cs8" :
< heads

Grchody Bde "rontent” style-"display: non2;®s

= doto~role="page"” id="meinView™ )

5 datdoroteshevder” 4ds "hedr? doks poskiian
s My sunance< b '

PRo iy

2
& = . = P i P 03 At 2o
wdiy data-role="conient ™ styie="pudding: Y8pr" ot
w/ divy

wi--gpplicetion UT goes herge-»

escript src="7E ini tpiions, 75 Bafsoripts |
esariph sro= i Mesurance. 78 welsoripts
sscript Seoe " IESmEssages. 78 s nerd gy

ks
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Next we'll add a second Page to our application by dragging Pace widget from the jQuery Moblle

Wtdgets section of the Pallet into the <kody> of our Mysurance.htm! page, after the mainView

Page as follows:

iBM Software

. -] Deleted: <#>Remove the
defauit "Mysurance” text that now sits
below the ScrollableView <dive> by
A deleting # from the sourse pana in the
Rich Page Editor pana.ff .
9 al7l

I Deletad: dujox.mob‘zie.SmliabIeVa
W

pe—

| Peleted: another ScrofabieView
1“-:‘-:{Deiebed: Dojo -
'-[_Fnrmatted Font: Courier
(aaleted SarollabieView

4 Header

S phel
55 Link

o

=i Lisy Yiew ,:

J
-
)
)

iList View ftem

‘rainiiew’

7. Dpenthe Msb;le Navigation tab and notice how vou can alfernate the chntents of the design iab *

in the Rich Patie Edifor by selacting which ig the active Mobile View —

icon s currently displayed in the design tab. Click the ciosed evehd o make that Mobile View

the view with the ppen eve

becoms the visible view in the editor. Clzck an the second ohe is.
bege.

VR fetaul

8 page

na

g Io switch to another

" | peleted: § :
{ Formatted: Bullets and Numbenng }
i)elemd After dragging and
dropping, the ‘Create a new Doje
Mobile Seroliable View” dlalog will
surface

| Formatted: Mo buflets or
L nunaenag

LSS

T,

s,
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8. Adda header for the second page.

Drag the Header widget from the iQuery Mobile Widgets section of the halette into the desian
fab of the editor, in e <div data-roie="pager id=’page”s sectionofthe
Mvsurance htmi file before the <« Sata-rele="content” stvie='paddin
section.

2t {ael

g;f Eink

i Mysurence izl 52

Agprd> .| Formatted: Font Courler, 11 pt

#nsert into Page
“page’ above
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- . { Formatzed: Fort: Courier, 11 pt J )

Formatted: No bullsis or

;_‘ numbsering
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8.  HModiy the HTML cotls of the page as foliows.

a. Change the id-atiribuis of the page view from

‘page’ {o ‘profileView”.

b. _Change the heading |abal from "Header” to "My Profile”,

Azta-add-back-btn= “srue” da

ca-back-

Agd the following code sfter the Id attribute of the page,

btn-texb= "Fomst

IBM Softwars

#Jﬁ&dy fd="contant :tyi &xsg"ay sones s
; ity doto-role= poge® {d-"aaintien
=Gty data-vols“fopder® id-Aeadir” detu-pesitions

iy dute-rolas"rondend” swiesr "padding: I§mx"wmaddien

LA

«wdtv dovs-role"poge”
wdfiv dote-role- “header”
<y Frofilec/h3s
< i
wily deba-reles"senbant® séyle~"paddingt ISpetsaidie
afdive

g "RoemRrd” dula-pieilione"Fixed s

fde"profileiien® doto-adé-bask-bloe Sirue Y doba-back-bbn-tert- "Home %

c%-—capp%‘wﬁ:#n Li goes her*w:

ig,__Jf you select the eyalid for the mamVlew mam\hew is
rendered in the design tab:

selected in the Mobile Naviaation tab and

T Cotiapsinin
2 Tollapsitile S8y
i Comtent

Centioi raup

FERed

sdhy gobo-reles "rostent® coyvie prdding: I5pateesdivy

ke “mroft Eavion™ dotuneit-basks Fine Mirue™ dotn -botd
i “humderd” delo-preitions "Fiaeds

i dakasrgle-"gege®
data-rgl pm hu
My Profiie<shin

T

<ty dptnerbia Eansens 7 stvie="pedding: ISpxTmidive

A5
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{ Formatied: Font: Courier
’i 1 Formatted: Indent: teft: 1.06%, Mo

- tﬁmatted: Font:. Courier, Not ~

A <= Ender profileview as thed.g
<#>Seject the Include heading

{ Deteted: viows i

| Pormatted: Fonk: Courler

f Formiatted

( Formatted: Bulles and Nurmbering
{ Beleted: T

-

bullets or riumbering

Hightight

Formatted: Indent: Left: 1,
Hanging: 0.53", No bullets o
numbering

‘(_Furmattedz Font: Monaco
| pefoted: q

e A A A A

chiekbox to include 2 heading. g
<#rEnter My Profile asthe
Heading label.y

<fFrEntar Rome s the Batk button
jzhe| to add & Back buktion label

‘| named ‘Home'.§

<#>Saient main\ﬂawfrnm the Back
butioh target drr_:»p-duwn soxql

| <#>Click Finish.to generate the
ScrolfableView code for our Profite
viewy

<#E-Open the Mobie Views lab and
notice how you can allernate the
contends of the design tab in the Rich
| Page Editor by selecling which! 757"

5 *Mysurance htng B2 5

<diy dato-deic
datn-dojo-

<ht deba-g
deta-2

< div

N alabord
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b heen By

{ Deluted: Views ]

. If you select the eyelid for the profileView, profileView selected in the Moblle Navigation teband -
rendered in the design tab. .

A i A o e e

£ “Mysurofce. fami ﬁ

@Hﬁmm 2

T Chethben
Ta Colizpsible
5 Colinpsitie Sex

wdiv dotn-roloe “pene” tdw et
i doig-relies Tacder” i "heacert dote-positisne Tl
hfdysurance v hiy
wde
«dix, dotomrolen "rostant” styles"pasdl

ediv cnta-dajd;
gdatoa-doio-|

<t deta-f[~
Gota-¢

T £ < ATV L

2 honer
«-ﬂ.My Profiiec; ?
< Gy
i dpio-roles"vogtent” siylaeTpadding: I5oxreldive

P i

wfdivar

Doteted: £

(!

- - | Formatted: Bullets and Numbering J

11, Complete navigation between the views. -
When we created the 2™ Pags view (profleView), we also created a back button for navigation __ .-~ { Delated: Sm"a_b’awew — )
back to the Mysurance horme screen (mainView). Now we'll add a toolbar butfon on the '} Delatnd: were given the oplion 1 the }
mainView which will send us to the profileView and complete our navigation. !
_a  Make the mainView tho active view in the Mobile Mavigstion tab, then go to the Palette.  _ -~  eleted: Views )
You can select the eyelid beside the mainView In the Mobile Naviga Vk:;.smed the . - { PalstediView |
mainview, .. e e Delatem )
_.b.  Drag a Button onfo the header portion of the gng;_nyl_qw and Insert into Header ‘header .~ | Doteted: ToolBar )i
after Heading (next to the "Mysurance’ header texd) , , o " .- | Deleted: ing J
{
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Checkbox

8 Collzpsils
% Cottapsible Set

 Combert
S Contrad Geougp

g

Diladog
jeid Container
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@ ’E&ysurmce.htm& b1

fnsert into Heades
*header after
Reading

3 Chetidaoy

] Coliapsible

£ Collapsible Set
B Content

3 Controt Graug
E?;'a?og‘

Field Coniainay

_a. Selectthe new butfon, which is cumently called ‘Bulion! right-clickon it and then selegt

"Properties’,

12, Eink the new bution fo the profileView mobile view.

5 Switch
o Tabgar
; & T3 TebBardaten
i S B Teemn
: 2 Texifox
#f) TonoieSuron
——
urance,htmd 22
onlo
; GRtae
. daca-d|
. <hi da
* | Deleted: i da

i-. | Formatted: Bullets and Numbering ]
. | peleteit: Laber ]
Deleted: , and a hovering 'Link to }

| Mobile View icon should appear
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Selacy AlF

& Undo Text Change
Revernt File
5 Save

of Cut

& Copy
2 Paste

¥ Delete

Riin As
Debug As

Jhe Properdies fab is épened. Look for property namie Thref” and set the value fg

.

O |

“#profileView (without quate)

Getting Started with {BM Worklight

~

Beleted: Click the Link to Mobile [

‘| View icbn to open the Link o Mobile &
View digiog. -

*.. - - Formatted: Font: Courier ]
- -{ Formatted: Font: Courier )i

; 4
Formatied: indent: teft: 0%, {

A Hanging: 0,557, No bullets or’
numbering

from the Inline mobile view pulidown .

irk to Mobile view
Select tha rubile view to fink

»,

Beleted: <#>Seiect the profileView ]

o=ty

e ——

I3
i
3
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Next we ll change the butfon labet from its default value of “Button” to *Profile”, and addg CSS

cless name fo relocate our button to the right hand side of the header.

_a. ln tne F’rcper‘;es tab, ook for property name “clase” and set the value fo "ui-bhtn-

A
£
Rouble glick the Bution currently called ‘Label’. It is now available io change the bution
label_Ghange the label from “Button” 1o *Profile” e
Jour butten should be labeled ‘Profile’ and should be on the right hand side of the header now.
Page 33
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1

" Deleted: <#>In the Dajo 1ab of the

Delehsd <#>Click Finish to
complete the link from this bulien on
the mainView io the profileView,

. | pofeted: Lapel

1 beleted: some infing C88

,1 Formatted: Font: Courier
_ [ Formatted: indent: Left: 0,55",

]
J
)
)
<[ Formatted: Font: Courier ]
)
]

‘| buliets or numbering

/| TooiBarButton

{ Deieted: Right cick the ]

/ | Formatted: Buliets and Numbering }

Deteted: and selecl Properties
from tha meru, You can double click
on the Properties lab fo maximize the
view.

doj u«-proys =]
sta-dojo-Lyps

| Formatted: Indent: Left: 0" |

Properties view, updaie the Labe!
with the new name for our button,

‘Brofile’. § CoE
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To s e — e s 2 Formatted: Buliets and Numbering

e e = = =~ - Deteted! in @ Rounded Ractangle
{dojox. mobile RoundRect)

a  DragaParagraph widget under HTWIL Tags from the palette into the mainView, inseding* .7 { Pormatted N

_— . {_ . . \
into the content, __ _ cwwwnn,  {Deleteds RoundRect )
. . " Deleted: Scnliableview )

1
i
14, Addfextfothe mainView ¢

& Myswanceem: 52 . -
. 1 Dejeted: below the Headi

{ Deletad: |

B1 Heading 1
B2 Heading 2
B3 Heatding 3
34 Heading 4
HS Heading 5

_b. [Pasiethe following texd between the start ard ending < G mihe
source fab. . .
A sample application built on the <b>InM Worklight Platform</be, using _z

HTMLE, CS853, JavaScript and the Dojo Mobile framework.

{ Deleted: Doubls—cick the newly
preated RoundRect fo bring it into
view in the Source: tab.

[ betsted: div
"{_De!ehed: RoundRect

)

i
" [ Deleted: }

)

)

It

'l Formatted: font: Courier
+{ Formattet: Code - Paragraph style
{ Detoted:; ¢
Usne akove or 3nippet #3 Irom
the accompanying labli-
{ snippets. txt file Tox {  Ti7):

&

S
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o
i ;
:
; .
! :

A

featly goto-roies "Feeder® ld="header” delo-posilipne 3
<hl dars-doin-vy

ehEeliysuranreaSh e

5

- “aprafiteVien” data-eole~"button” 1d= by daze-doje-pr
I . : “burtos date
balgaanadding.  1hawl, ‘ .

tion built om the ~bniBM Park cA-dojn-t

. : T tmroit EDDLL

f drka-reles poge”™ fd= "profilelisw™ dota-udd-back-bbs

Qi rosen Shtadar® i hearorB” s Ser i ;
{ " Dalabed:
! 15. _Add a button to the profilgView. This butfo 01 7 A permattes: Butiets anc Numbering ]
: _ “~ - peteted: ] -
_& Inthe Mobile View, dlick on the eye icon to change fo the profileView page.

(. SRR R D)

J; e : *try=swrance bl £

] B mysurarce btrnd 52 = ;] s

i

i :

!

I ;

. .

i

]

L

b.  Drag & Button from the palstte and drop into the profileView below the Heading,
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; @;, Migturance.boml E§

=] Creckbax
7 Cobapsible
=2 Colfapuible Ser

{8 Conterz.

TR . Deieled: In the Bulton's properties
T page, change o e Alliab. E

. -y f : £ : H rumbetad +
16 in the Buiton's g_mgrerties page, chanae to the jQuery tab Check the boxes for “Compact * g’;iﬂﬁﬂ% Sh,:ﬁ 1,23
version” and "Inding”, .  Start ak: L+ Alignment: Left +
| Atigned at: 0"+ Tab affar: 0.55" +
;\Izident ab .55

JE——
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R i { Formatied: Indent: left: 0" Frst
*Mysurancebonl B S A fne: 0°
g 35 Burttan ;
[ Checkbox 3 L
! £ Caltapsibls Sot
i &2 Comtent g
‘|
{ .
I k comple oppiicoticn built ;m::‘:::“
{ ' : E—
hemi b body ¥ Page b Costent . .
 Guediv dota-role="poge” {d="profileiies iy T . [
{ 5 ‘wdiv duke-volew "hender” ids "heade E Kpery i !
] <hisMy Profiles/his Therne: |
H
' deta-rotoe Stonbent™ stile="pa & Rownded comers
: =i ies Thit ton @ -
: - : Conrmpa version
|
! - paine
L
i ) R Yo e ;
{ i7. _Prepare the button o launch a dialog when clicked by adding the function o the onclick property ™|
| {we'll implement this functicn in JavaScript in a few steps). :
4 L
_ a Inthe same properties view — All teb, enter "onclick” in the filter field to narrow down Y
: the pro ist, :
% P peﬂy fist . ‘_‘ De!ggd,bd___d..d.__*_.___.
i N . . . - i
__h.  Inthe enclick property, add the following function as the value. Foramatted: Bulets and Numbering |
; loadsSinplebialog{*Bution clicked on My Profile!:*)
1 . o
( - _.&  Minimize the properties view and go back io the Mysurance.htral editor:
.
H
|
L
i
i
|
)
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htmi b body b Page b Comtent K

-2

m*s:an;ﬂ a',rthmugix

18, Adda Container (xdiv>} to the mainView.

This step is primarily cosmetic, but aiso accounts for some spacing inconsistencies in different

browsers and environments. it is & very common HTML/CSS practice. it places xdiv>tagsin .-

our views that will be used by CS8 for controlling the vertical positiohing of our page content, | it
will provide visual separation from the Header and help account for spacing inconsistencies in
different browsers and environments. ’

__ & Usethe Mobile ﬁav;gaﬁmn tab {0 bring the mainView back to the foregrmmd of the
design tab.

b. Add a Container {<div>} o the mainView by dragging the Stvle Container widget from _

the palette and inserting intc the Sontent before the <o tag,

d@ Mysurance bl B

irdine fame

st into
Content above

e e

18. Add a class name to the Contalner, so that we can apply CSS for margins
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Dafeted

- 1 Formattert: Bullets and Numbering

] !

Js

— - - Formatted: Font: Courier

{ Fonua!:iﬁéﬂ: Font: Courier

- { peteted: {ony RoundRect and
Button, so far)

h { Deleted:

- [ Beletet: Views

. | Formatted: Font: Courler

- { Deieted: Serosabieview

" 1 Deleted: Roundrect

| Formatted: Font: Courier

Mysarance.himl I8

Serolableview
‘mairiiew’ before
Roungect
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Select the Container <div> line in the source pane.

B o ot e e e s e et e e o e e m = tm o wm m e e e e o

Switch o the Properties view and ensure that the Container element is displayed.

Switch 1o the Styles tab within the Properties view.

Enter spacer as the value for the Class property. The CSS file will have a reference for
the class named spacer’ whlch this container will lnhent

e Plugeing
i Flash
£ Oblect

icZ line Frame
A KMarggee
£ 5evle Container DNV

</

gty gota~rolew “Be@

ity petaereice poge”
atiiy deta-rolesx"Héager” {d- "heeder8” dabnp~position-:

it
<giv dato-roles “rontent”

Hi-Mynurancaahis )
<2 bt "Eprofi IeWiew® dote-role- bution" ide"

padding: Z8pat

iddm "prafileview” duta-add-back-®

<h3zMy Frofilehis

style="poddingr I3

20 AddaContainer {zdiv>) lothe profleView. -

Use the Bobile Mavigatiou fab to bling the profiieView back to the foreground of the
design tab,

Add a Centainer (<div-} fo the profileView by dragging the Styie Con

the palette and inserting Into the Content before the Button

iner widget frem
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. | Formmatted: Fonk Courer
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1 Detetnd: Views

.| Formatted: Font: Courier
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H "Mhesurance.html 83

@ Mysusancediond 83

e Blug-ins

Insert inte -

£ Flash 3 ! Serolablevien
_ : o Hevieal before
By Chiecy S ’ o
insert ido & e i ; : Buttor
Cantant abiove i Inline Frame i
il i
A Margues .

21, Add a class name to the Container, so that we can apply CS8 for margins. . | Doleted:
. L ‘{annatt.-.d: Bistlets and Mumbering _]‘~
—& Selectthe Container <div> lineinthe sourcepane. . .. ... ... _... .. { Deletet: dojox.moblle. )
_Db. Switch to the Properties view and ensure that the Centainer element js tisplayed. 2
__c Swiich to the Styles tab within the Properties view. )
_d.  Enter spacer as the value for the Class propery. The CS§ file will have a reference for {
the class named “spacer” which this container will inherit. i
S
[
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s Flash

g Dhbiect

il Inline Frame
2 Masmues
£ Style Contairer {07V

LR T e g g "Erbe i T 3
<@iv data-rolew "header® id="headerf” dnt
<hEsMy Profileciiiis

gt

lspacar

=t--ppolicotion UT goes Mere--»
eseript seesisSind dlptions, {8 rofserints
wsoript seo="fslMysurance, 75 e soripts

wweript sros "fRilmessoges. J5sedsoriphs

Fout {Default Fort Face)

22, _Add CSS to Mysurance.css fo provide 2 "branded” look the Mysurance application, overriding  ~
defaults and glving & more consistent experience across different devices.
_a inthe Project Explorer view, find and open
Hysurancelappsifysurancefcommoniessiysurance.css in the editor, and paste
the following CSS text to the bollom of the file:

T o rm i e o e am St e e e Mi W s e e M M em em e e — e = - e e m e e e e e e ML R MG R L e e oo A Se - e o e e me e e e o

L Bnacer | . . ; . -

margin-ton: 7400

cuiopags {0

L ui-content p {
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23, _Add the JavaScript function to implement our Simple Dialog pop-up.
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The fina! step before previewing is to add the function that the "Click Me!® button on the
profileView will invoke to generate a popup message on the device,

To di spfay this message, we will use a Worklight Comimaon Contral, WL SampEeDm{og Workllgh{ I Fommtiad: Font: (Courier
prevides a set of Commoen Controls as part of the JavaScript library that offers-simplified and
consistent cn-device options for commeon adtivities and visual elements. 1t includes things like
busy indicators, modal popup windows, fab bars and oplions menus. Some of these are also
available in JavaScript, some in Dojo and other JavaScript libraries; and some anly in native
SDKs, with differences in support on various devices. Providing as WL.* Commen Controls
improves the write-once, run-anywhere development experience.

’ from the accompanying labi-
snippets b file for tut & paste §

Farmatted: Bulﬁeisandﬂumheﬂng
Formatted: Indent: First fines 0° ]
bDeleted: ¥ ’ }

Deieted Use sbove or Snippet ¥5 f

__a. Inthe Project Explorer view, open the Mysurance.is file by navigating io
Mysurancefapps/Mysurance/common/jsiMysurance.js.

b. Paste the foliowing function text into the bottom of Mysurance js.
Jungtion loadSimpleDialoy (dialogText) {

WL, Simpiebialoy. showi ‘Helio! ', dialogrert, 1{
text: 'Dismiss:,
handler: function() .
{WL.Logger.debuyg [ "button pressed"); }

S e

11

§ A sample appllcaﬂor'a built o

= Worklight Platform, using
C$83, JavaScript and the L
framework.

1
i

o his function accepts a string from the caller {diafogTexf), and invokes the Woarklight 1 Cnmmon ~
Controf WL. SimpleDialog.show(), passing a fifie for the dlaiag, he text to display in the diziog,
and defails zbaut the dismiss button, which cffers the ability tc call a furiction as the dislog Is

dismissed.

Save all open files and return to Mysurance himi,

On gertain combinations of platform and Rich Page Editor browser selection {browser buttons on 7 |
the menu bar of the editor pane or Window > Preferances > Web > Rich Page Editor), you will

see the C8S changes reflected immediately in the Design tab. Otherwise they will always be
available during Preview In the Mobile Browser Simulatar, or when the application is launched on |
an emulator or an actual device. :

[
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1.6 Testing Android and iPhone versions in the Mobile Browser Simulator

in this section we'll see the stength of the new Mobile Browser Simulator for development time rendering
in znh integrated, device-specific contziner,

/1. Preview the iphone environment in the Mcblle Bmwser S[mulatar

mé. ln the Project Explorer view, expartd the Mysurance project > expand apps folder »
expand Mysurance foldsr and right-click iphone enviranment > Run As > Preview,

__b. This will show the appiication and how the navigation works on the iphone environiment.

sample application builf on't
erklight Platform, using H
S58, JavaScript and the Do

[201‘2»&0?-&0‘} 08:1 irth emrironmeanr oo
{2012-07-04 O5: %
0i2-07-03 08:1

202-07-04 081

The studio will force a rebuild and prompt fo save any open files if necessary. Select Yes if prompted:

Page 44 Geifing Staried with |BM Worklight
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NoOte: As the simulator opens, you may need to accept the prompts to aliow Java to execute on this
page. ) ) o

Notice the Cordova settings in the left hand pane, which aliow yoli fo test changes fo various on-dévice
settings within the Mobile Browser Simulator, Also the Device selectioh menu and orientation options at
the top of the Simulated device window.

Mobile Browser Simulator

web pages in & variely of mobile browser sizes ard shapes.

5538, JavaScript and the Dojo Mebiie
framewiork. .

Navigate between the Mysurance and My Profile 'pages’ to test our navigation, and fry the Click Me!
Button on the profile page to bring up our Simple Diglog.

Page 45
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2.  Repeat preview for Android by selecting the android application node in the Project Explorer

{MysuranceflappsiMysurancefandroid), right click and Run As > Preview.

01%-0%7-04 D
20120704 I
BiZ-07-&3 D

el 5.0 18}

Getting Started with 1BM Workfight

JE—

PRI

H

JEnS—.

H
i
i
i
b
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tse the simulator o review the application function on Andreid, Nav;gaﬂon look and feel should be very
mm%lar to theriphone, due to our custom CSS,

Expanci the puildown on the current device selection (HTG Evo 4G), then expand the Android section
and notice the targe number of Android device options for simulation.

24
£

fobile Browser Simulator

| The Mobile Browser Simutaior displays mobile web paces in a vatiety of mobile browser sizes and shapes,

4 Motoroia DROID Pro
). dotorola DROID K
E§ Seny Ericsson Expatia Arc
LG Opfirmus ¥ YMSTT
Amazon Kindie
Samsyng Google Neduys 8
B4 HTC Desire
Wotaroia Draid Bionic

Fire

Samsung Galay Nexiis
3} mMotorola Drofd RAZR MAXK
3 Samsung Gataxy Ace

HTC Thunderhok

5 TG e
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Appendix - References-

IBM Workiight Developer Edition

hit:/iwwew Jbm.com/developerworks/mobileAworkiight htm(

Geiting Started

hitto:/Awvew-01.iom.comysoftware/mobife-solufionsiworklight/liprary/

iCuery
hiinfwens jguery. cony

iQuary Mobile

Wit Aquerymobite. comyf

Documents

hite:fipic.dhe.ibm.comvinfosenterwrkighivGroms/index.jsp

ﬁttps:!!ww. ibm. comideveloperworks/mobilerworklight/gstting-started/current-documentation. hing

hitpflapliouery.comf

nipfouerymobile comfdemos/1.2.0f

hitos:/iwww, . com/developerworks/forumsiforum. ispa?forum|D=2830

. { peieted: ]

._»!aaiebed;ﬂ
-
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During the runtime of an application, the main HTML document cannot be
replaced by another HTML document. The Worklight Client framework
’ ~ initialization is bound to the bedy during the onload event occurrence. .
For possible init options, see the Worklight Developer Reference Guide.

smiria chorsete"uif~£™ Ff»

gt fiames "visaport® contents “widthedevi ce-width, initigl-sonitel. &, mowiso-se
whi bt Mysurancewiiities .

<Tink rele"shortout Joor” hrelf="imges/fovicon. pag® />

=itk relw"gpple-touch-icon® hrefs"inegessapple- touch-icon.pag”
«iink rele“stplssheet” hrefurssraset, cs3" /5

<iink relsstyleshpetr™ hrefs "gss/Mysuronte. css” 7»

EE

wsiripl sroeisllvserence, 75 ol soripty
wsreiph srvs "I messugss, 75 el neripts
wsaripd sroe Tfdsauth, J8 e soripta
S hardys
<l

uree | Sel

TPage 121 123 Beleted UL TR SUEGeR Chan

§ - P ) W, . s : .
! In the init method, enter “timecut:2000, onConnectionFailure:
! doConnectionfailure” (without the quote) inside the onload method of

the <body> tag.

17772013 3:30:00 PM_.

¢t ErieB Chan

- Page 13 [3] Deleted. -+ -7




s

<IOGLTYBE hiwiy
o ochimis
whoags
<mnia chersebs"eff-8° A
EELE NanEs “wisnport” contente Widthedevice-width, initial-sceioel. 8, maximum-scolest.d, ploiput-s
<kiilesMysurgntpc/eitTes - - . : - - - - T
rele"sharseit {con® heels "iNpgass fovicon.pog® i
rate “gpple- fouch- 1ron™ hivate"imeges/apple-téuch-feen. arg™ A
<link rele"siyleshael® href="rssrosct, cos”™ 7

(i rel="stylesheet” hrefa"Css Mysurance.css” /»

ﬂinﬂ%&-’i’;ht‘.‘& dotopnectionke: Ut oy 7 B2

wsoript sroe "jadvsurance. 35 xo/soriphy
sseriph srow "iEAMRstages, i3 el s ipty
wserigh sroeismeth, §8 el soripis

Expand the common then js folder, open the Mysurance.js file. This is the
application’s main JavaScript file. lf contains the wiCommonlnit() function
that will be inveked automatically once the Worklight framework
initialization completes. You can add your application’s initialization code
here.

£7 Borklinhd comEs selth £he ueey Srcmesork husgisd inside. Y vou do not went to sse it, pleose cosment
swindow.$ ~ WL :

forchion wilommenTnit(}{
ZF Lommon inttiatizotion code gons haps
¥

#7Tn cese server i3 not availobie dea't feil bub run in disconnected mude estesd
Funckion dofonnectionFailureM )
#k.Logger  debug{ *Mysurence.is: Horklight server unowaileble, running in disvennected mods."};
ot Cormmonini t);

You will édd the callback function that was specified in init method earlier by
adding in the following portion as shown in the image above.

n'% fail butrt veon in diseonnscted mode

function doConnecticonFailure ()

WL. Logger.debug{"¥ysurance.js: Worklight server unavailable,
rpnning in disconnected mode. ")

wlCommonlInit{};

}

Use above or Snippet #2 from the accompanying labi-snippets.ixt file for cut & paste.

Save the Mysurance s file

H
H
H
H
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- Page 25{[4] Deleted

“Pages” in a mobile application are built on views. For this application we are
using dojox.mobile. ScrollableViews, which are dojo view widgets that manage a
view pane. Ensure that the Mysurance.himl file is the active file in the editor
pane, and that the design or spllt ediforiabis \nsxbie

14742013,

' EriéB Chan

Step List, Quttine numbered + Level: 2 + Numbering Style: a, b, ¢, ... + Startat: 1 + '
Alignment: Left + Alighed at: 0.55" + Tab after: 0.55" + Indent at: 1.06"

L EricB Chan 7o

Select the include heading checkbox.
Enter Mysurance as the heading Iabel.

Click Finish to complete the ScrollableView. If you have the Split tab open in the editor,
you can see both the visual content and the source being added to your
application :

Craate a new Doio Mobile Scrollable View

Croate & new Dojo tobfle Scrallable View

Page27:{7]Deleted - .. oo i Erie chan © 1j7/201% 5:34:00 PMT



Remove the default "Mysurance” text that now sits below the ScroliableView <div> by
deleting it from the source pane in the Rich Page Editor pane.

{
L

data~dojo-props="selesnteditrue, Sorolidir: "wi T
<hl data-dojo-types"dojox.mebile. Heading™

Sava-dojo-props=Tlialbs Hysuraenos'  f
<f Al ’

ppiication 91 goes here ——» ’

sre="ig/Mysurance. f8"</ scripts
sro=Yra/messages. je<fsoripts

e

172013 61100 PM.

: Page 29: 8] Deleted |

Enter profilevView as the Id. -
Select the Inciude heading checkbox o include a heading.
Enter My Profile as the Heading label.

Enter dome as the Back button label to add a Back button label named ‘Home'.




Py

Ay

o

Select mainView from the Back button target drop-down box.
Click Finish o generate the ScrollableView code for our Profile view.

Open the Mobile Views tab and notice how you can alternate the contents of the design
tab in the Rich Page Editor by selecting which is the active Mobile View — the
view with the open eye icon is curréntly displayed in the design tab. Click the
closed eyelid to make that Mobile View becorne the visible view in the editor.

7/2013 10:55:00 PM°

_In the Dojo tab of the Properties view, update the Label with the new name for
our bution, ‘Profile’.

Lah Profile

Swiich fo the All tab within the Properties view and scroll down to the siyie
property.

Enter fZoat:right; as the Value for the style field. Press Enter {o make
sure the value is accepted. This will force the button to appear on the
right hand side of the header.

htral B body ¥ ScrollableView ¥ Heading BE

_ setTransiﬁ&ﬁ?é;i -
spelicheck
. srchlodeRef

floaturighis]

submire
tabindex




“Page 34: [10] Formatted, .

Outline numbered +Level: 2 + Numbering Style: a; b, ¢, ... + Starf at: 1 + Alightment: Leﬁ
+ Aligned at: 0.55” + Tab after; 0.55" + Indentat: 1. 08“

"Use above or Snippet #3 from the accompanying 1ab_—
gnippets.txt file for cut & paste.

<51/7/2013 13125:00 PM.

i/ Page 42: 112 Deloted -

spacer { -
margin-top: 100px;

}

.mblView {

background: —webklt—gradlent(lfnear ieft top, teft bottcm from{#096093},
FO#HT) limportant;

'

.mbtHeading{

background:-webkit-gradient(linear, left top, left bottom, from{#379AC4),
to(#086193)) limporiant;

}
.mblToolBarButionBody{

background-image:-webkit-gradient{linear, left bottom, left top, color-stop(0,
#0BOBOD), color-stop(1, #4349489)) limportant;

}
.mblArrowButionBody{

_ background-image:-webkit-gradient(linear, left bottom, left fop, color-stop(Q,
#0BOBOD), color-stop(1, #434949)) limportani;

872013 1216:00 AN -




[N

}
.mblArrowButionHead{

background- xmage ~webklt~gradient(§mear left bottom left top, color—s’mp(ﬂ
#0BOBOD), coEor—stopﬁ #4340401) imporiant;

}

F workaround for white on white in simpieDialogs >/

- #Wldialog {

color:black;

}-,
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Chapter 6: DBZ

Objectives

in this exercise, we will learn;

= Review response from BB2 server

e  Parsing the result and integrate with mobile app

Exercises

1. Open DB2Training as the active project to use.

fe 22 WL Server Hibwary
B Eserverfiava

B o2l bavuSoript Resources
Zxoarlapers

¥ & DBZTraining
W =

b & images
g =
b 2= legal
# {Ebin

i romponents
¥ Sosarver

IBM Software Group
Prepared by Eric Chan

¥ 2 RE Svsters Library Bava SE5 Mac0S Y R

b &2 muery.mobile-1.2.0
@} DEZ2Fralning. btrrs

iﬁg application-descripsar.smi

e Perform database records requeét from Worklight to ﬁBZ Server

january 12,2013
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2. - Let's make the Worklight enable to communicate with the BigFix servern

First, create an HTTP Adapter in the Worklight Project. Find the Worklight

Worklight Hybrid Application
Workiight Inner Application
n Worklight Shell Component
L] Worklight Native APt

[ Worklight Environment
% Worklight Application Ei&m

3. Choose the current project (i.e. DBZ Training) in the field “Project name” and

choose “S(IL Adapter” for the Adapter Type. Enter a name for the adapter,

here we will use “DBZAdapter”.

Worklight Adspter

CTroxte o new sdaptes.

DBEZyraining

{BM Software Group
Prepared by Eric Chan Z

January 12,2013
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4. Configure the adapter with the ¥ML file. Open “DBZTraining.xm".

F @ aﬁam&rﬁ

5. Define the connectivity settings as follows:
- Driverclass: com.ibm.db2.joc,DB2Driver .
- URL: jdbe:db2://192.168.120.270:50000 /TEST
- User: db2admin

- Password: passwozd

wdriverllossscom, ibm, dbZ, Joo DEZDriver</driverliass
eurl=jdbe:dh?: /192, 168, 128, 170 B8O/ TES T/ urls
<userr»dbZadmincusers '
<pasgwordspassworde/pusswords
</ oot asou ]

6. Declare adapter procedures. Remove zll pre-defined procedures and define a

new procedure called “Get”.

el pdupber nomes B Treisiag®
xmins xsie “Hitp ey, 83 org PBBLXEL Schemn- i nstance”
Fming reie "hitpiYear, worklight, cogfintegrotion”
s s sqle "Rt tpr A woarklight . condintegrotion'sgl®

wdizplovibone-DB2Training</displavkicees
zgesoription:lBZTraining=/descoription
<oonnectivitys
cogrmertionPelicy xsirtypes"3gl; 5§£€ﬂﬁﬁ@{§rﬂrﬁvixry >
wgntafourcelefintitions
<griver{igssroom. ibhm. dbZ. Joo DR river<fdriveriinsss
sirizjdbcdb2: /5192 168, 120, 178 SRBAA/TES T ur i
ingiedbZndmi nefusars
f@ﬁa5wﬂ?é}yaaswﬁrd&§§ﬂsgﬁﬂr4%
=fdataSourcelefinitioe
<foomnectionPelioes
ciogdlonstraints sexloncorrentlaonnectionsPFeriindes"5" /&
ef rommrertivitye E

Fo EmEs et s

vl zadugters

[BM Software Group :
Prepared by Eric Chan 3 January 12,2013
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7. . Implement procedures in the JavaScript file. Open “DBZTraining-impljs’.

¥ (> adapers
¥ = DR Tralning

8. Remove all code and insert the folbwing: ' : o

var trainingStatement = WL.Server.createSQLStatement { "SELECT

¥ FROM TRAINIKG");

.

function Get{) {

return WL.Server.invokeS{QLStatement ({

e
H
3
§
i
H

pr'epareldStatement * trainingStatement,

parameters : [

9. Now, try if the adapter can retrieve response from DB2Z Server

JR——

B2 Tral .ri ing-isepige 89

FiTraimingBigbi TrainingAadroid

vop troiningGtatoment = $L.Server. cronteSOistotement("SEIECY ¥ FAOM o
B oo ) i
o DRZTraining L ;
ijx"»w}_ﬂmr Ubrary ifupstian Getll 4 :5
» ol * I ceturs BL,Server, invokeSgLStotemantl] &
e e ! Tt wnt : broifingStotement,
$ 25 JRE Systeee Librery Hvm S5 64 New = :

Fdbejocjor - Alsrafheithilar Go lntg
b =3 IavnSennr Besnumres

; i Copy Chualified Name :
S apps | & Paste ®Y. L
# Delete =
Build Path EN
Move...
» gaiquery.meblie-1.2 ¢ Rename... 73
: #iEi
- B DEITraining e iz lmport...
: ® g3 lagal i mxExport..
é’% application-dasoiptor : 3
gt hin F Refrech F5

Erromponeats

Vaidaie

§3 1 Deploy Worklight Adapter
Pl e .

S

g
Profile &s
Team B
Compare Witk W
Restore from Local Hisinnge..
Sowurce Wy

o waisngSlatement ! iy

Properties £ ]

IBM Software Group -
Prepared by Eric Chan 4 January 12,2013
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10. Choose the corresponding project name (i.e. “DB2 Training”) and adapter

name (iLe. “DB2Training”). Choose “Get” as the procedure name to invoke.

Keep parameters empty and click “Run”. -

Edit configuration and faunch,

BRITraming

= = i ?‘w e
Invocation Result of procedure: 'Get from the Worklight Server:
“sSuccessiul™ true,
resuitset’s {
"CONTENT" "helln world®, o
1, i
“TITLE™ "est®
E!
kN
CONTERT: “helln world 2%
2, .
"TIFLE™ "pezy 2%
¥ :
i i
i
[BM Software Group .
Prepared by Eric Chan 5 January 12,2013
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12. Then you can go on to integrate the resulis into the mobile application. The

application layout interface has already been provided. You shouid write code £

to display the results. Open “DBZ Training.js”.
¥ S apps - _ = , _ ;-
¥ S DEZTraining '
¥ i COFnTRngt
B fZnoss
B Eximages
b @ jpuerp.mobite-1.2.0
T

B & messages.js {
5| DEZTraining hten

13. Inthe gei(} function, create an invocationData object for the procedure call

with the follbowing format

pr—

var invocatidénData = {
adapter: 'DB2Training’, {
procedure: 'Get’', i
parameters: [] - P

}: L

Fill in corresponding information for the procedure call

14. Create an options object to define success and failure handlers.

var coptions = { ) ]
onSuccess: getSuccess,

onFailure: getFallure ) |

}s

15. Createa Worklight Procedure call

WL.Client.invokeProcedure{invocationData, cptions);

i6. Now you can test the application.

IBM Software Group :
Prepared by Eric Chan & January 12, 2013
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Chamer 1: Contest Environmemnt waﬁkthmugh

Objectives

In this exercise, we wili learn: . . . : R . .
e How to boot up the programming environment using VMware

How 1o log in and start up pecessary services and system software

L
“&  Examine the sample appiication which will be used in the programming contest
s How to perform programming using the GUI environment
e How to use eclipse and create, import and export project
Exercises

Partl. Open vinware

1. Using the Explorer, navigate to the VM folder and the double click the VMware
virtual machine configuration file with name " Prog confest training.vaic" and then

boot up the VMware,

1503 s AM
1Z3E96 KA VitualMachine Disk.., L4013 11:01 Al
25,526,544 KD frbusl Machis Dsh...  [FAfZ013 10:27 4
LRE  ¥Muare snapshol m...  [MU2013 1101 AW
KB VMhvare VienEE mac..  LJ4fE0LS 11:03 aM

TER Ywares team member  1{3{7013 7:21 PM
26KE  Yhwwrs vt mac.,,  1/4/2613 10:28 amM

2ISKB  Text Dacument 1j4Z013 1027 AR
2ZT P, Teuk Document 14Z013 1003
“ZDKE  YextDorument 1452013 11:51 A

SKE YMwarewirtualmar... 1iA4{2013 11:01 8¢
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0 06 to Wimdpaws ©

User name: administrator
Password: password

1 SCreen appeais.

3. after login, firstly we open the folder “Server shorfcus” on the desktop. Then we
click the file “Srarf the WAS server” to start the Wehsphere Application Server.

curents 57 SettingsiadmiristratotDesitop\ Served shartout

121982012 3

12152012 3:26 PM
i2i19lz05e 327 P
12/1942012 2:26 PR
1271302002 328 PR
12018{2012 3:34 PM
12f19{2012 9:34 PH

brbbhbh%

PON—

JEE—,
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JE——
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P —
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4. the following screen will appear:

We can see that Server launched. The screer will automatically close when the web
server start successfully.

5. Te test whether the web server started successfully, go the following URL:
https:flocalhost: 9043 /ibm/console/logon.jsp

NebSphere integrate
Sotutions Console .

User Iy

erved:
rvfemzet s of

3t esisle - Bresaity of 1565
- 355, dhen 1548 fomp.

- User name: admin
password: password
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6. after login, the following screen will be shown. The page is used for setting the -
web sérver. . ‘ '

ER T

W toist H AL omiend)

B il

Tnygrabad Snivtiuns Cormie,

5.0t .

£k Number greLZIEG
i

a2

Itwgraited Solutions Sonesie provide Tt el traive

£ Hipls prosiect. The Guble i b sreduct s that
b hdrmanictared thoamgh this Instadlation, Skl & pradud cuit 1o
more micimation.

UV PrEp— P —

U,

PN,

[ES—
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Part2: Open Eclipse and new project

1. To develop program, open “Eclipsz” on the desktop

2. Sefect the workspace path. The workspace stores the projects that you developed
before. :

Select n warkspaoa
Etlizsiz SDK storen yor prowcts & a folcer cabed 8 worksoace.

Choase & Workarace: folder b i Tor ths session.




-
H
H
i

IBM
Programming Contest 2013

3. Create the new worklight project on eclipse.

File > New > “Worklicht project © .
i Dl f

¢
H
¢
‘
%
4. When creating the worklight project, choese the project templates. Choose _
“Hybrid Application” ' {
- {
Waiklight Project
Zieats anew V@kﬁg*ﬁ DrejT, )
=
£
ke Asp i i
% Tnner Apphration g
 Ratfys 4PT é
@ shell Compensnt
|
i3

{
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5. Type application name and press finish

¢ Hyhrid Application -
Configure the Fybrid applizsbon that Wi be created song with the WerHight project.

|
i
i
{

}}-
/
i 6. After creating worklight project, the package explorer shows your project on the
[ feft. If there is no package Explorer, you can go
Wirlow > shaw view > “Package F oy
E:’.
{
|
i
|
; .

.
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7. To test the project which runs preperly, Explore apps > test > right click > run as
> “build all and deploy”

w 1oy sefverpiva

TR
ks v
et
SRR
ST
i ba s

rnse

e

N
e

=

R

e
-W‘;\iw‘ww“f‘” e

S ka&“ﬁ«w%%"f

o ””m

¢
|
t

{.
E

gh
S

H
i
i
:
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9. Tick the new environment you want to add. The pew environment inciudes
Mob;l, desktop and web. Then fimsh

EU——

. Wnﬂmght Ervironment
£ Creste appliction foklers for hew envirarensnis.

it

14, To test the new envirowment runs properly, Right click > ran as > “android
application™

R

P

{

i

AT,
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11. The android emulator will show on the screen.
; . i

12. Another way to test the new worklight environment is to open the simulator in
the web console by the following URL:

kitip:/Rocalkost:8080/console or http://IPaddress: 8888/ console

{this prethad § ) fed Becanne i is fosfer than the cmulator)

wt
Lt unatae =L Bl 30803 15T

3 % Gpaews Somion {8 < sk #’ A pametion W Beabicy, Backen
b CTE S L T
Usstrmenissar. Hana

T issims workn i

PS. If the consele dees not include anything, please try the step 7 again

JrS—— [E—

i
H
i
Losan
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Part3: Export project

1. When you want to export the whole preject out of eclipse, the eclipse provides the
export function.

The step is: - : . : - S

In the eclipse, choose File > Export > General > “File System”, and choose directory,
then next / finish

2. then the export project is located on the target directory




sty

}
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“* the alternative is te export as a zip files...
3. In the eclipse, choose File > Export > General > “Archive File”

r

Archive file
Export resources to an ardiive Fie on the local Fic system.

.

[ — re— J—

N ——

¥
i
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Part4: Import project

1. to import the project from the outside, File > Import > General > “Existing
projects into workspace”, and tick the hox “copy projects into workspace”
(Depends on which fype of files you export), then next / finish

B

Import Projects

i .
3 Select & drectery o search fiy endsting Eclipss projects.
H

2. The project is imported and show ox package explorer

{*3 2 IRE System Library [iee7?
- server/java
3% JavaScript Resources

components
e SErvEr
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show

e

elete Resources:

**%1f you want fo entirely delete the project, please fick the box. If tmrmg5 don’t tick it.
Otherwise all contents in the project will be deleted.

£
:

o e, R . rSoy— re— [mm——

i
H

.
i
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Appendix [ Multiple Choice Screen Walkthrough

Objectives
In this exercise, we will learn: -
e How to connect to the multiple choice screen

e Howitologin

e How to answer each multiple choice question

e How to submit your answer once you are finished

e How fo examine your submission status
Exercises

1. Inthe VM that is started in Chapter 1, open an Internet Explorer and type the URL

hitp//(ip to be provided)/mm1web
You will see the login page like this,

Flcase Aot er soms tli'l'u of v
the syster willbog yous aut autrg-nat..ulw and
w.xt(xmgr' ] agam : .

z Licenzeé Materials « Broperty of IB% Corp,
i @%mgh: IBM Coreoration zad ks licensors 2087,

mh Yo IBE hoge L 30d Cagno o tradernecks of
i IBE Comp. g in many

S

in the TM1 Server.

In the Log In screen, just leave the Admin Host blank, and select *‘p}annmg sample”

Next, Login into the multiple choice application by the supplied credentials.. After
you had logged in, you can check if the team name and user name is correct.
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t Hame: TOmel

e *
Please chtihied or on fie boffor fab fo go fo each ueliin
ol Piggse Brovide your qreston fies
A Ans §
B Ans 2
< Ams 3
a2 Ans 4
E Aoz &

Team Name Uer Name

Burnrnary

3. Afier logged in, the first question is displayed and selects the correct answer in the
drop down box. Click Next for the next question

Dlease chok Next o oo the boltem fal fo go fo esch gussfion

o Plagse Proviths your guasfion feig
3 Ans
=} Ang 2 - -
c Ane 3 Select your answer in
o Ang d .
E Ans§ this drop down box ]

Summary

4. To navigate to different questions directly, you may access it through the bottom tab.
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Piease sk Ko o or the botio teb mgo}eeafmq;@m
iyl Please Provide your queston Hers -
2 Ek*”é Click Next for the / uestion
o Py
£ Ans B E:::]
Click Summary page fo submit
Questign navigation bar
GCopnng, Sumimary
software

5. In order to submit your answer, you must go to the summary page and review your
answer. For your convenience, you may also answer the question in this summary
page directly from cach of the drop down box besides the question number. Note that
your Status now should be “Not Submitted”. After you confirm it, press the button
“Subrmit”, '

Status: Mot Submived
¥ou van charge your acswer bere. Please oliok on the submdt bistlen lo sebmit your anseer. Nole that you can only subref

ey

Alternatively, o

you can input | & Submission Status

your answer | &
here o
owis

Press Submit button when
you are done \

Gogmos,
oliware
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6. Omce you submitted, a confirmation box should be appeared. Also check the status
should be changed to “Submitted™. If vou got an error message, please contact your

 judge.

windos

Team 1 User Name:  OmeCha St Submigeed
You cart change your answer here, Plense 6iigk = the submit bution o submit your answer, Mofe fhad you can only submit #4ce.
Sunmine

Status get
updated

Coghos,
softwire

7. If you iry to resubmit your answer, you will get an error message like this.
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i “Teamt1  lserMame: OneChal Stmis:  Submitred

I You van change your anawer here. Ploase oficic on fe spbmit Sutfon fo subsslf your ansenn, Sbfe thef you can onfy submif osse.
. - Symma

-

I

!

r

{

f'

!

!

| Cognas.

i software

i

" If you submit again, you will get
i error message
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